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Dear friend,
Why did you buy Power Macintosh Programming Starter Kit?

Maybe you want to migrate existing Macintosh programs based on the
older 680x0 Macs. Maybe you're considering programming the Mac for the
first time now that Apple has made the jump to light speed with the
PowerPC-based Power Macintoshes. Or maybe you're simply curious about
doing your software development work on a Mac.

All of these are good reasons for buying this book, which was written by
my good friend Tom Thompson. Tom, who has been programming and
writing about the subject for more years than either of us cares to remem-
ber, is a senior technical editor for Byte and an unabashed Macintosh fan.
Back in our salad days, Tom edited my Macintosh column (“Macinations”)
for Byte, a task that I'm sure shortened his life.

The point of this book is not to shove any single programming doctrine
down anyone's throat. The truth is, there are a number of good program-
ming environments and systems that are available (or will become avail-
able) that allow you to compile native mode Power Macintosh code on
680x0 Macs and on Power Macintoshes. Apple’'s own Macintosh Program-
mers Workshop (MPW) with its Power Macintosh Software Development
Kit and other systems will do the job nicely for a number of folks.

Having said that, this book does take a stance—as any expertly written
programming book ought to—that using the new CodeWarrior unified
programming environment from Metrowerks makes a lot of sense for both
migrating 680x0 Mac programs to the Power Macs and for creating new
Power Mac software.

In fact, I happen to agree wholeheartedly with that sentiment. While I
understand the power of MPW and its many tools and its flexible modular
structure, I also love CodeWarrior's unified and lean approach—a love that
Tom shares. CodeWarrior does a great job of taking the tedium out of the
edit-compile-link-crash cycle of program development. While Tom's book
will work well for folks who want to get an introduction to Power
Macintosh programming, but who will eventually work with MPW, it really
shines as a construction set for CodeWarriorites. That design is conscious
and is reflected in the limited version of CodeWarrior included with the



book, along with running versions of the sample programs Tom has devel-
oped for you.

I can't overrecommend this book. Frankly, I'm a little jealous that Tom
could write such a technically excellent book with such smoothness and
directness. Tom and I and the Hayden team of technical editors and pro-
gramming experts have spent many extra hours ensuring that all the code
examples are tight and error-free and conform to Apple's programming
guidelines. As someone who has taught programming at the University of
Chicago for nearly fifteen years, I am proud to have this book as part of the
Don Crabb Library. Please feel free to let me know what you think, too.

zm Coutit-

Don Crabb
May 1994



Introduction

This book is a road trip. In it, you'll find information on Power Macs, RISC
technology, and a C development environment by Metrowerks called
Metrowerks CodeWarrior. You'll find an assortment of programming hints
and tips and insights into how the Mac works, and you'll discover what
new features—and pitfalls—await on the Power Mac. Most important, while
I'll supply plenty of programming examples, I'll also explain how the Power
Mac works. I firmly believe that if you understand how something works,
you're in a better position to use it (or in the case of a personal computer,
program it).

What You'll Need

My basic assumption is that you know how to use a Macintosh and have
some knowledge of the C programming language. If you're not familiar
with C, the best reference on this language is Kernighan and Ritchie's The
C Programming Language, Second Edition, published by Prentice Hall. You
should also have Apple's reference works on the Mac Toolbox, Inside
Macintosh. Of course, you'll have a demonstration version of Metrowerks
CodeWarrior because it's on the CD-ROM accompanying this book. If you
don’'t have a Power Mac (yet), that's OK. Much of the material in here works
with existing Macs as well, which is perhaps the real beauty of the Power
Mac design.

I have structured this book so it offers material useful to both novices and
experienced Mac programmers. The novice should begin at the beginning,
but more experienced programmers should feel free to browse about and
find a subject of interest. Consult the brief summaries at the beginning of
each chapter to determine if the material is of interest to you. The following
brief road map will help you decide your course.
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The Road Map

Chapter 1 covers the Power Macs themselves, with a brief peek at the
processor—the PowerPC 601—that gives these systems their great horse-
power. It also discusses how these systems manage to run existing Mac
software, thereby preserving that pile of Mac software you've accumulated
over the years.

Chapter 2 provides a tour of Metrowerks CodeWarrior, Metrowerks' high-
speed integrated development environment. Here, you'll be shown the
environment's editor, compiler, linker, and project manager. When you
write a C program, you must pick the version of CodeWarrior to create
either 680x0 processor (68K) code or PowerPC (PPC) code. CodeWarrior can
also generate a file with both PPC and 68K code types (called a fat binary).
This feature enables your program to run on any Mac. This process of
making a fat binary isn't automatic, but we'll show you how it's done in
chapter 6.

Once you're familiar with the Metrowerks CodeWarrior environment,
chapter 3 helps you write your first real C program. It won't have a friendly
Mac interface, but it will perform a useful job. If you're new to the Mac,
bypassing the user interface details for the moment limits the number of
unknowns you have to deal with while you gain confidence with the
development tools.

In chapter 4, you'll tackle some of those user interface details dodged in
chapter 3. You'll add a friendly interface and discover the forked nature of
Mac files. If you don't know what a Mac file's data fork and resource fork
are, don't worry. This chapter will explain them to you. You'll also learn
about resources (which, not surprisingly, reside in resource forks) and how
to edit them for use in your program.

Chapter 5 is a rest stop on our journey. We will have reached a point where
we must lay aside our tools for the moment and gain some insights into the
Power Mac's new system architecture. I'll explain how Apple managed the
feat where one set of source code can support two different processors. 1
go on to describe how the underpinnings of the Power Mac, as much as it
resembles the 68K Mac on the surface, are fundamentally a different
operating system. I'll explain what code fragments are, and what they
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mean to future application design. I also describe Apple's Mixed Mode
Manager, the part of the operating system that manages to keep two wildly
different sets of processor code—the 68K and the PPC—operating in har-
mony. It will be of general interest to most readers, and required reading
for those writing special programs and extensions. Finally, I'll explain how
both 68K and PowerPC code can be embedded in a single application file
called a “fat binary,” that's capable of running on either Mac. You'll use
some of these details later when we explore certain Power Mac-specific
features.

Chapter 6 is where you put into practice the information you learned in
chapter 5. Most of this material will be of interest to advanced program-
mers. We'll write an application that controls the Mac's File Sharing soft-
ware. This will require writing a function that works with the Mixed Mode
Manager to enable a switch between 68K and PowerPC code. I'll also show
how to make this application a fat binary, capable of running on both 68K
and Power Macs. Next, we'll write an Extension that changes a Power
Mac's screen depth. You'll see how to access code fragments. It also dem-
onstrates how to patch the operating system, both for a 68K Mac and
Power Mac.

In chapter 7, it's time to focus on how to fix a program that misbehaves.
Information on the types of debuggers, and debugging tools can be found
here. A look at CodeWarrior's high-level debugger is provided. Tips on
debugging, and defensive coding are discussed.

For those who want a better understanding of the processor, Appendix A
provides a look at the PowerPC family.

Appendix B consolidates information on how to port an existing Mac
application’s C code to the Power Mac. It will be of interest to advanced
programmers who just want to dive in and start retooling their programs
immediately.

Appendix C provides the complete source listings for the programs dis-
cussed in this book.

Appendix D tells you how you can locate more CodeWarrior and Power
Mac programming information.
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The Limited Verison of Metrowerks
CodeWarrior on the CD

The version of Metrowerks CodeWarrior that is on the CD that came with
this book is limited in that it can only work with the sample code also
provided on the CD. Other than that limitation, it's functionality is the same
as a full-fledged version of Metrowerks CodeWarrior.

This text of the book was written using the full version of Metrowerks
CodeWarrior. You'll have to use slightly different steps when using the
limited version on the CD. Since the limited version can only work with the
sample files provided on the CD, the commands Add File... and New Project
are not available.

So, if you are following along using the limited version of CodeWarrior
that’s on the CD, when the text tells you to use the New Project or the Add
File... command, you should instead open the related project file and keep it
open throughout the exercise. All the associated files will already be in the
project and so you won't need the Add File... command. Then, you can
follow the same procedures as if you were using the full version of
CodeWarrior. '

We've provided all the code discussed in the book on the CD, so you don't
have to retype it, unless you find it valuable to do so.

You should also note that Metrowerks cannot provide technical support for
this limited version. However, there is a way you can get all the
CodeWarrior information you could ever want and also meet other Code
Warriors. See Appendix D for details. Once you buy a full-up version for
your very own, then Metrowerks will be happy to provide full technical
support.

Additional Notes

There are probably better ways to write some of the functions presented
here and I welcome input from you. However, the purpose of my code is to
illustrate Power Mac features while being readable by an audience of C
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programmers with a wide range of experience. I also bias my code towards
readability because, more often than not, six months later I usually have to
modify the code for use in other projects.

While I've tried to produce error-free code, and I actually use some of these
programs in my day-to-day work, it's possible that some of the code ex-
amples have bugs. Please send me bug reports via E-mail or some other
means. If you have access to AppleLink, my E-mail address is
T.THOMPSON, while on the Internet it is tom_thompson@bix.com. If you
prefer a more conventional method, mail your comments and bug reports
to me in care of Hayden Books.

Please note these signposts along the road as we travel.

Backround Info

Question mark icons flag sections of the book where additional background
information can be found. For those unfamiliar with a topic, this extra information
promotes a better understanding of the material. Seasoned Mac programmers
can skip these sections.

Important

Exclamation point icons signal important topics. These sections provide informa-
tion necessary to understand the material in each chapter, or illustrate an
essential point on the software or operating system. Even seasoned programmers
might want to examine these sections for Power Mac-specific details.

Hazard

Bomb icons signal potential hazards. These sections supply crucial information
required to keep your program from crashing and your Power Mac system
intact. Do not skip these parts of the book.
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User input text appears in a bold monospace font, as in
Type MyFile and press Return.

Directives, routines, streams, and functions appear in a monospace font,
asin

Before we call Munge_File(), we fetch the stopwatch cursor icon using
GetCursor().

Filenames appear in quotation marks, as in

For a complete source code listing, check the file “switchBank.c” on
the CD-ROM.

This symbol w has been used to represent program lines that have
wrapped.

Well, enough preliminaries. Let's hit the road...



The Power Macs
and a Brief History

In early 1994, Apple changed the face of the personal computer
industry—again. The company took a powerful processor
technology previously available only in expensive workstations
and offered it to small businesses and average users through
affordable desktop computers. Importantly, these low-cost
computers won't run those arcane workstation operating
systems. Instead, they offer an interface renowned for its ease
of use: the Macintosh operating system, or Mac OS. Put simply,
Apple has introduced a new line of high-performance Macin-
tosh computers, the Power Macs.

Since these Power Macs borrow heavily
from the Macintosh design, a brief history of the
Mac itself is in order.
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The Early Mac

Just a decade ago, Apple introduced its newest personal computer during
the 1984 Super Bowl. This famous commercial, titled “1984" and directed by
Ridley Scott, depicted a bleak, gray, future dystopia where shaven-headed
drones shuffled toward the ultimate video conference. A runner—hammer
held high and wearing an Apple logo on her shirt— raced onto the scene,
hotly pursued by the faceless thought police. The hammer was hurled at
the conference screen, shattering it. The implication was that Apple's then-
new Macintosh computer would save us from that same gloomy fate. The
verdict is still out on whether or not the Mac accomplished that goal, but no
one disputes its effect on how we deal with computers and information.
Desktop publishing, digital image editing, color printing, and other applica-
tions were either invented on the Mac or driven by the demands of its
users.

The original Macintosh (now termed “classic Mac” in Apple's technical
literature) was a small beige box with a 7.83 MHz 68000 processor. It came
equipped with a built-in 9-inch black-and-white monitor, 128K of random-
access memory (RAM), a single custom 3 Y»-inch Sony floppy drive, two
serial ports, and 64K of read-only memory (ROM). The classic Mac was a
“closed system” since it offered no slots or easy expansion capabilities.

The Mac ROMs provided a large array of support routines that imple-
mented the graphic user interface (GUI) and system services such as
memory management and file I/0O. These routines are known collectively
as the Mac Toolbox. Since it is easier to use the Toolbox services than write
code from scratch, the Mac has always encouraged a consistency in appli-
cation design. Much of the Mac's “personality,” or behavior, comes from
these Toolbox routines.
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Important

Because Toolbox routines are relied on heavily when writing a Mac application,
expect to become familiar with them as you progress through this book. Keep
Inside Macintosh nearby; those manuals provide important details on Toolbox
routines. As you become comfortable with programming the Mac, you'll fre-
quently consult them when writing new applications and adding features to
existing applications.

'=

Since well-behaved applications only access the system through the
Toolbox interface, Apple has retained the option of significantly revising
the hardware and software behind the interface without requiring modifi-
cations to existing applications. For example, a new Mac might use a new
stereo sound chip, but your application would still use the same sound
generation routines and be able to play music or sound effects on it. The
Toolbox sound routines still present the same interface to the programmer,
but the code undemeath this interface layer converts your program's
commands into a format the new hardware understands. This design
eliminated many compatibility problems as Apple enhanced both the
Toolbox routines and the hardware. Of course, not all compatibility prob-
lems were avoided, but Apple was able to limit them by using the Toolbox
to define a “virtual machine.”

Just as important, the Mac GUI helped enforce a consistency in the
application’s user interface, making Mac applications easier to use than
those on other computers. Once you mastered one application, you knew
the basics of using other Mac applications as well. To be sure, there were
application-specific features you had to learn (text formatting in a word
processor, or how to use a pen tool in a drawing package), but users didn't
start over each time with the basics. They could always count on finding
file manipulation commands under an application'’s File menu, and locating
the editing commands in the Edit menu.
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Faster and Better

Over the years, Apple improved the original Mac and introduced new
models. First the company added more memory and a SCSI port. With the
Mac II, Apple used the faster 68020 processor and opened the computer’s
closed design by adding NuBus slots. It introduced newer Macs with faster
processors and a larger array of features. These machines went by such
arcane names as the Mac Ilcx, IIci, IIsi, IIvi, and IIvx. Apple minimized the
confusion temporarily by giving certain product lines unique group names.
The Mac notebook computers were labeled PowerBooks, and the first
68040 processor-based Macs were dubbed Quadras. Numbers were tacked
onto the end of the names to help identify the characteristics of each
computer. Still, things got out of hand. A mid-range line of Macs, labeled
Centris, appeared and disappeared, being integrated into the Quadra
product line. Apple introduced a Performa line of Macs, which were identi-
cal computers but repackaged for the home market. Mac system taxonomy
and nomenclature began to require a scorecard—a very large one at that.

The Modern Mac

This brings us nearly to the present. Apple was feeling competitive market
pressures to lower costs and improve performance. To reduce hardware
design costs, Apple standardized most of its computers on three basic
models.

B The first model uses a low, compact chassis with minimalist expan-
sion capabilities to reduce costs. This design debuted with the Centris
610, followed later by the Quadra 610. It has a single Processor Direct
Slot (PDS) that's connected directly to the processor bus. By use of an
adapter, the PDS can accept one NuBus board.

B The second model is a desktop configuration that offers three NuBus
expansion slots and more capacity for internal peripherals. This
chassis was first introduced with the Mac Ilvx and was subsequently
used in the Centris 650 and Quadra 650 systems.

B The third model is a mini-tower chassis introduced with the Quadra
800 and followed by the Quadra 840AV. Like the second model, this
tower system offers three NuBus slots. However, there's ample space
for three to four large SCSI hard drives internally, plus a beefy power
supply to support them.
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All three models have a bay for adding an optional CD-ROM, other remov-
able media drive, or a high-capacity hard drive.

In the area of performance, Apple had been investigating the use of RISC
processors in future system designs. This research was evident in products
such as Apple’s 8:24 GC display board, which uses an AMD 29000 RISC
processor to accelerate screen drawing. Also, the company demonstrated
System 7, which was written for the 680x0 processor (henceforth known as
the 68K processor), running in an emulator on a Motorola 88000 RISC

Processor.
. ’/I )
Background Information \
RISC is the acronym for Reduced Instruction Set Computing. This processor Q//

design achieves its high processing speed by implementing many simple instruc-
tions. These instructions are usually of a fixed length and execute very rapidly,
usually one instruction for every tick of the system clock. This speed is accom-
plished by limiting what each instruction can do. For example, there is a handful
of instructions that load data from memory to a register, or store data from a
register to memory. All other instructions perform fast operations on the contents
of the processor's many registers.

Also, these instructions are carefully tailored to minimize overlap between the
operations of other instructions. This lets processor designers add execution
units—subsections of the processor dedicated to a specific function, such as an
integer math unit and a floating-point math unit—that can run in parallel and
boost performance by executing two or more instructions simultaneously. As you
might expect, simpler instructions require you to use more of them to implement
a specific task, so RISC programs are typically larger than Complex Instruction
Set Computing (CISC) programs.

We can contrast RISC processors with CISC processors like the Motorola 68K
and the Intel x86 family. CISC uses variable length instructions to achieve high
code density (that is, lots of instructions can be packed into a small amount of
memory). These instructions, as their name implies, can perform a sophisticated
set of operations and use a wide variety of addressing schemes. One instruction
might perform an operation on a location in memory, then step to the next
memory location. Another might retrieve a value from memory and then perform
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a math operation on it. While some of the simpler CISC instructions can be
completed in one clock tick, many cannot. There are several reasons for this.
First, because of the variable-sized instructions, the processor is forced to
decode the incoming bytes to determine an instruction’s length. This takes a
clock cycle to perform the initial decode, and then the processor spends addi-
tional clock cycles reading in the rest of the instruction. Second, a complex
instruction that modifies a memory location requires extra clock cycles to
perform the bus operations necessary for the memory access.

Finally, the very complexity of CISC instructions often requires the implementation
of a small internal processor—a processor within a processor, so to speak—
dedicated to instruction decoding and processor control. This internal processor
uses programs called microcode that perform the decode operations. Again, this
additional layer of complexity requires extra clock cycles to shuffle instructions
through the decoder and operate the microcode that translates the instruction
bits into processor actions. Because of RISC's simple instructions, a sophisticated
decoder isn't required: You won't find microcode inside a RISC processor. The
RISC instruction decoder is implemented completely in hardware and runs at
hardware speeds. It takes only several clock cycles at most to translate a RISC
instruction into its corresponding actions. A RISC processor's performance is
better than a CISC processor's because it can execute more instructions for a
given set of clock cycles than the CISC processor.

If RISC technology is so much better than CISC, why is the latter so pervasive
on desktop computers? RISC came onto the computing scene much later than
CISC. RISC came out of research at IBM, Stanford, and Berkeley in the early
1980s, and wasn't commercialized until the middle of that decade. In contrast,
Apple Computer sold its first microcomputer, the Apple |, in 1976. By the time
RISC pracessor architecture appeared in the computing industry, CISC processor
architecture had been in use for practically a decade.

While CISC has a big advantage in terms of an existing software base, RISC's
performance edge should entice users to make the switch. RISC not only allows
personal computers to run today’s tasks such as spreadsheets, image editing,
engineering simulations, and 3-D image rendering significantly faster, it also
provides sufficient horsepower to enable a host of new system services and
applications. Some of the new system services might include a robust,
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preemptive, multitasking operating system, integrated telephony and fax func-
tions, voice and handwriting recognition, and speech synthesis. New applications
would be real-time data processing, effortless 3-D image generation and manipu-
lation, and all sorts of multimedia work.

Apple and IBM, Who Could Have Imagined It?

In 1991, Apple teamed up with Motorola and IBM to form an alliance to
define the next-generation processor for future desktop computers. Despite
the huge legacy of applications composed of CISC code on their respective
platforms (Intel x86 code on IBM PCs and Motorola 68K code on
Macintoshes), they decided that only RISC offered the necessary perfor-
mance. Cost was an important factor here too: What hindered the accep-
tance of other RISC systems was the high cost of the RISC processor's
fabrication, which in turn resulted in expensive computers.

The alliance is designing and producing a family of RISC processors to be
introduced in stages. Each family member is targeted at a specific segment
of the computer market. The first family member, the PowerPC 601, was
introduced in April 1993. It's targeted at the low-end desktop market, but
offers better performance than today's most advanced CISC processor,
Intel's Pentium. In October 1993, the alliance introduced the PowerPC 603,
a low-power sibling to the PowerPC 601. It is geared toward the note-
book market. In April 1994, the PowerPC 604 was announced. Its high-
performance design with multiple execution units addresses the mid- to
high-range desktop market. Even faster PowerPC processors will be
introduced over time.

The PowerPC 601 processor is a 32-bit implementation of the 64-bit
PowerPC architecture around which these chips are designed. It has a
high-speed 32-bit address bus and 64-bit data bus. Three independent
execution units—an integer unit, a floating-point unit, and a branch unit—
work in parallel to process as many as three instructions at once. A flexible
32K on-chip cache helps minimize execution stalls by keeping frequently
used code and data in the cache rather than fetching it from slower main
memory. To learn more about the PowerPC family of processors, read
appendix A.
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The PowerPC 601 (from now on, I'll just call it the 601) is the heart of Apple's
new line of RISC-based Macintoshes. These systems, mentioned earlier, are
called Power Macs to emphasize their performance. There are three sys-
tems, and each targets a specific user (see table 1.1). Each system is built
around one of the three standard model designs discussed earlier. Each
Power Mac comes equipped with a base 8M of 80 nanosecond RAM, a hard
drive, builtdin Ethernet, and 16-bit stereo sound hardware. Also bundled
with these computers is AppleScript, a batch control language for automat-
ing certain tasks, and QuickTime Extension for multimedia support. An
optional AV Technologies expansion board that provides video I/0 and
digital video capture can be plugged into the PDS slot on these systems.
Bundled with the AV boards is the PlainTalk voice recognition software
and the text-to-speech engine.

Table 1.1 An Overview of the Power Macintoshes

==
Power Macintosh 6100/60 7100/66 8100/80
Processor PowerPC 601 PowerPC601  PowerPC 601
Speed 60 MHz 66 MHz 80 MHz
Cache optional optional 256K standard
Perforrmance ~25% faster Nearly 2x

than 6100/60  faster than 6100/60

Native apps 210 4x 68040 @ 33 MHz

Emulated apps fast 68030 to 68040
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Power Macintosh  6100/60 7100/66 8100/80
RAM 8M standard  8M standard 8M standard
DRAM expansion 72M 136M 264M
SIMM slots 2 4 8
Expansion Slots One 7" NuBus 3 full-size NuBus 3 full-size NuBus
Storage
Standard 160M to 260M  250M to 500M  250M to 1G
HD configs
Floppy 1.4M with DMA 1.4M with DMA 1.4M with DMA
CD-ROM Optional Optional Optional
Video
DRAM video Standard Standard Standard
VRAM video 1M standard 2M standard
VRAM expansion 2M aM
Standard support 1 monitor 2 monitors 2 monitors
SCSI High-speed High-speed High-speed
asynch asynch asynch
Dual SCSI channels
Networking
Ethernet on-board with
DMA channel, AAUI connector
Other built-ins

16-bit audio stereo in/out with DMA

2 Serial ports—LocalTalk with GeoPort
compatible with DMA channel

Apple Desktop Bus (ADB for input devices)
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The Power Mac 6100/60 takes aim at the low-end user by providing a RISC-
based Mac at a low price. It uses the Centris 610/Quadra 610 chassis and
the 601 processor is clocked at 60 MHz. The Power Mac 7100/66 uses the
Centris 650/Quadra 650 chassis. With the 601 clocked at 66 MHz and three
NuBus expansion slots, this system should meet the mid-range computer
user’s needs. The Power Mac 8100/80 stakes out high-end users, with its
processor clocked at 80 MHz for best performance. Its Quadra 800/840AV
chassis contains ample room for several high-speed SCSI hard drives, and
memory can be expanded up to 264M, which should satisfy the needs of
the most demanding power user. Both the Power Mac 7100/66 and the
8100/80 provide a second monitor port, which you can use to expand the
screen work area or to run a different operating system on the second
monitor.

The number after the slash in each Power Mac’s name denotes the speed
of its processor clock. This naming scheme enables faster versions of these
Power Macintosh systems to be shipped with the same name because only
the trailing digits change. This arrangement eliminates a lot of the confu-
sion created by the previous method in which minor changes to existing
Macs begat whole new model names. It also explicitly states the processor
speed, which is handy when comparing systems.

As nice as these systems are, you might suspect that there's a catch,
especially regarding software compatibility. After all, didn't Apple and the
others sacrifice the existing software base on the altar of performance?
Apple tries to let you have your cake and eat it too by placing a 68LC040
emulator in the ROMs of these systems. This emulator is a sort of “virtual”
68040 processor that can execute the 68K code in existing Mac applica-
tions without modification, but this emulator doesn't support the 68040's
floating-point unit (FPU) and memory management unit (MMU) instruc-
tions. (Only very eclectic utility applications would ever try programming a
processor's MMU, and such code won't work anyway with the Power
Mac's vastly different memory architecture.) The emulator is complete in
every other detail so it can run the bulk of the existing 68K-based Mac
applications and utilities. Lack of an FPU in the emulator may or may not
be a problem, depending upon how smart the application software is in
dealing with the machine environment. If the application simply expects
an FPU, it will crash. Some applications detect the absence of an FPU, and
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either refuse to run, or will do their own computations in software. This
slows down the application significantly, because such software computa-
tions run in the emulator. Those applications that use Apple's math rou-
tines will run somewhat faster, because portions of these routines were
rewritten as PowerPC code.

One reason the emulator works is because of the virtual machine defined
by the Mac Toolbox routines. Recall that Mac applications obtain system
services (such as reading a file and drawing to the screen) through the
Toolbox, and these Toolbox calls act as well-defined entry points into the
operating system. What Apple accomplished with the Power Macs was to
literally slide a RISC processor into the system and then use “native” (that
is, PowerPC) Toolbox code to handle the application’s requests. For ex-
ample, the Mac OS provides a set of screen drawing primitives known
collectively as QuickDraw. An application's drawing functions that use
QuickDraw on a 68K Mac continue to work on a Power Mac without
recompiling the application. That's because the Power Macintosh ROMs
present an identical QuickDraw interface to the application, even though
this QuickDraw is written in PowerPC code. Whatever application code
isn't using the Toolbox gets executed by the emulator.

This is a simplified explanation of the situation, of course. The Power Mac's
operating system has to know at any given moment whether it's emulating
a 68K processor or running native PowerPC code. This is a serious problem
because not only is the instruction set different, but the system environ-
ment for each processor is different. There are all sorts of system variables,
arguments pushed on the stack, and other elements that have to be ac-
counted for when execution switches from the emulated 68K processor
environment to the PowerPC processor environment and back. A Mixed
Mode Manager built into the ROMs along with the emulator manages this
context switch. It keeps track of what processor environment the applica-
tion is currently in, switches the context to the different environment when
required, and makes any required adjustments between the two. Such
adjustments might pass a drawing request to the native Toolbox code,
while another adjustment might communicate the result of the request
back to the calling program. For the most part, Mac programmers won't
have to concern themselves with how the Mixed Mode Manager works,
but there are exceptions. I'll cover them when we get into Power Mac-
specific features in chapters 5 and 6.
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For those of you still waiting to hear about a catch in this setup, here it is:
The emulator—not surprisingly—musters only the performance of a fast
68030 or slow 68040 processor. Performance varies, depending upon how
often the 68K application calls the Toolbox routines written in PowerPC
code. Since Apple estimates that Mac applications spend 60 to 80 percent
of their time in Toolbox code, it's possible that a 68K application runs faster
than emulated speeds because it spends most of its time actually running
native Toolbox code rather than running as emulated 68K code. The perfor-
mance question is complicated by the fact that, for compatibility reasons
and time to market issues, Apple hasn't yet ported all several thousand of
the Toolbox calls to PowerPC code. 68K Toolbox routines that weren't
ported get handled by the emulator. In some cases a call to the Toolbox
might execute native code, resulting in a brief performance boost, while
another Toolbox call might continue through the 68K emulator, for a perfor-
mance hit. It's also important to note that the overhead of the Mixed Mode
Manager handling numerous context switches can degrade performance.

So are these Power Macs faster or not? Yes, they're faster. The emulator
and Mixed Mode Manager provide compatibility for existing software.
They serve as a bridge that allows 68K applications to run until the real
solution arrives: these same applications written in native code. For such
native applications, the overhead of the emulator and Mixed Mode Man-
ager practically disappears, with the exception of those Toolbox routines
still implemented as 68K code. Over time, applications will run even faster
as more of the Mac Toolbox is rewritten as PowerPC code. You can expect
future releases of the Mac OS to replace more of the 68K portions of the
Mac OS with native code, yielding better performance. However, early
reports indicate that despite the mixture of 68K and PowerPC Toolbox
code, Mac applications recompiled into native code run very fast on the
Power Macs. On the low-end Power Mac 6100/60, such native applications
run at Intel Pentium speeds. These same programs run nearly twice as fast
on the Power Mac 8100/80.
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Time for a Change (to Power Mac)

To make the switch to native Power Macintosh applications, programmers
need development tools that can compile their existing application code
into PowerPC code. While there are many different development tools
available, the best possible situation would be tools that run on both 68K
Macs and Power Macs. Source code that you wrote and tested on a 68K
Mac could be copied to a Power Mac and easily recompiled, making the
initial application port to the PowerPC a snap. (Note: those applications that
are fine-tuned to the 68K run-time environment will require some adjust-
ments or even a major redesign.) The result is a pair of applications, each of
which runs on 68K Mac or a Power Mac. With some additional work, you
could combine the code in these two applications to make a fat binary
application, one that could run on both types of Macs. Or, if the target
audience is just Power Mac users, you'd simply write your source code on
the Power Mac to begin with. Application testing and maintenance would
be further simplified if these tools also provided a source code level
debugger.

Such development tools exist. It's time for you to meet Metrowerks
CodeWarrior.



CodeWarrior:
A Guided Tour

This chapter provides a brief overview of software develop-
ment, and introduces the CodeWarrior development tools.
Intermediate and expert users can browse this chapter for
specific features of the CodeWarrior compiler.

One of the most aggravating aspects of programming is the
wretched edit-compile-link-crash cycle. You know how it goes:
write the program source code, compile the source code, link
any libraries to the resulting object code, run the linked
program...and watch it crash. Next, you use the debugger to
determine what caused the crash. Finally, you
restart the computer and the cycle begins anew
as you start editing the source code again.
There's no escaping this development cycle for
the moment,
unless there's a
huge break-
through in
software technol-
ogy soon. (I'm not
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holding my breath while I wait for that to happen.) The realistic solution is
to make the development environment faster. A faster turnaround time on
this cycle means the programmer, rather than waiting on a slow compiler

or linker to run its course, spends the recovered time writing more code.

The code writing situation has improved dramatically with the introduction
of integrated development environments (IDEs). An IDE combines all the
development tools—editor, compiler, and linker—within a single application.
With a keystroke or a menu choice, a built-in editor creates a new file
window where you can enter a program's source code. Another keystroke
runs the compiler on the source code, and yet another keystroke links the
code and libraries. If you're feeling really brave, you can even launch the
resulting application and test it. When you quit the application (assuming
you don't crash), you land back in the development environment. These
IDEs greatly accelerate the turnaround time in writing software, and such
development tools have been wildly successful in the personal computer
industry. The first IDE was Lightspeed C, pioneered by THINK Technolo-
gies, and introduced in 1985. (This was before the company was acquired
by Symantec and the compiler was renamed THINK C. To minimize confu-
sion, I'll call it THINK C from now on.) The PC has similar development
IDEs.

Metrowerks CodeWarrior offers such an integrated environment. Metro-
werks CodeWarrior is a software tool kit that features several utilities and a
compiler that contains the IDE. If you've used an IDE before, especially
THINK C'’s, then you'll feel right at home in CodeWarrior. For this book
we're using the C compiler, but the CodeWarrior CD contains a Pascal
compiler as well. For fans of Object Oriented Programming (OOP),
CodeWarrior's C++ compiler is part of the C compiler. The Metrowerks
CodeWarrior toolkit comes in several configurations. A Bronze package
offers a 68K version of the compiler and produces 68K applications only.
The Silver package has a fat binary version of the compiler. It generates
PowerPC code. This compiler thus runs on either 68K Macs or Power Macs,
but makes only PowerPC programs. The Gold package supplies both the
68K and PowerPC compilers.
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CodeWarrior Requirements

One big advantage to CodeWarrior is its small memory and disk footprint.
On a 68K Mac, the compiler requires System 7, a 68020 processor, 1.56M of
RAM, and 7M of hard disk space, although Metrowerks recommends a
68030-based Mac and 5M of RAM for best performance. On a Power
Macintosh, the CodeWarrior compiler requires 2M of RAM and 7M on hard
disk. The compiler application, which hosts the integrated environment,
weighs in at just under 1IM. The usual army of header files, libraries, and the
source code debugger application comprise the rest of the space. There's
also an OOP application framework called PowerPlant and a Pane editor
called PowerPlant Constructor. The latter lets you rapidly design parts of
an application’s interface.

Now that you know what CodeWarrior is, find out what it does. Take the
CD out of the book and insert it into your Mac's CD-ROM drive. If you have
plenty of room to spare, you can drag the entire contents of the CD-ROM to
your hard drive. (If you're using a 68K Mac, you can follow along too. With a
few exceptions, CodeWarrior looks and operates the same way on both
computers.) Try to preserve the organization of the folders when you make
the copy, because certain programs such as the Toolserver rely on this
arrangement. The book also directs you to certain files based on this setup.
If you don't have sufficient room, double-click on the Software Installer
alias icon. After the Installer application launches, click on the Continue
button to get past the trademark screen and read the notice for late-break-
ing information. Click on the Continue button again and choose the soft-
ware you wish to install on your hard drive. Click on the Install button and
pick a destination drive and folder in the window that appears. When the
Installer finishes, click on the Quit button. Open the Metrowerks Tools
folder for your type of Mac (68K or PowerPC), followed by the Metrowerks
C/C++ folder. Now double-click on the Metrowerks C/C++ application icon
to launch it and start touring the development environment.

[

Important

This text was written using the full version of Metrowerks CodeWarrior. You'll
have to use slightly different steps when using the limited version on the CD; the
limited version can only work with the sample files provided on the CD so the
commands Add File... and New Project are not available.
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So, if you are following along using the limited version of CodeWarrior that's on
the CD, when the text tells you to use the New Project or the Add File... com-
mand, you should instead open the related project file and keep it open
throughout the exercise. All the associated files will already be in the project and
so you won't need the Add File... command. Then, you can follow the same
procedures as if you were using the full version of CodeWarrior.

The Toolbar

After the compiler launches, the first thing you'll notice is the Toolbar, as
shown in figure 2.1. This Toolbar serves double-duty as a command center
and status indicator. The upper half of the bar has an array of buttons, each
with its own icon. These buttons represent frequently used commands;
clicking on a button with the mouse executes the corresponding command.
It's pretty obvious as to what some of the icons do. For example, the printer
icon represents the Print command, the scissors icon depicts the Cut
command, and the paste jar icon signifies the Paste command. But what on
earth does that cracked egg icon mean? It's easy to find out: just move the
pointer to the icon and text explaining the command it represents—Disas-
semble, in this case—appears in the bottom half of the Toolbar. With this
built-in self-reference, it shouldn't take you long to learn what each button
does. If the text for the command appears italicized, it means that the
command is disabled. Using the Disassemble command shown here as an
example, the command isn't active because there's no file open; it has
nothing to work with.

€ File Edit Search Pro_|ect Tools Window

Disassemble

Figure 2.1 The Toolbar

The bottom half of the Toolbar is the status display. This is the area where
either the command name for a button appears, as described above, or the
current status of a development tool is indicated, such as searching, com-
piling, and linking.
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Don't worry if clicking on buttons isn't your style. CodeWarrior uses good
interface design and lets you work with it the way that suits you best.
Those who prefer to point-and-shoot menu items can find all the Toolbar
commands in the menus. If you'd rather keep your hands on the keyboard,
there are keyboard equivalents for these commands. As always, you find
these keyboard equivalents cross-referenced in the menus. If necessary,
the Tools menu even lets you hide the Toolbar. Just think of the Toolbar as
a container of frequently used commands that you have ready access to
onscreen. '

What if you don't like the commands in the Toolbar or the arrangement of
the commands already there? No problem. You can customize the Toolbar
to suit your needs. To rearrange the buttons, press Control and click on the
desired button. A dashed outline appears around that button. Next, drag
this outline to the desired spot on the Toolbar and release the mouse
button. Your button appears in this new spot. The other buttons shuffle
about to accommodate the button’s new position.

If you don't like a certain command on the Toolbar, you can delete it by
pressing Control-Command and clicking on the offending button. To add a
command, press Control-Command while selecting it from a menu. Up to
fifty-two buttons can be added to the Toolbar, although the limit actually
depends upon the size of your monitor. The Tools menu has several com-
mands that deal with the Toolbar. The Hide Toolbar command hides the
Toolbar. The Anchor Toolbar command “anchors” (makes immovable) the
Toolbar at the screen's upper left cormer. Or you can unanchor the Toolbar
so that you can drag it to a different location onscreen. The Reset Toolbar
command restores the factory-default buttons in the Toolbar.

The Project

CodeWarrior manages software development through the use of a project.
This is a special file that consolidates all the source, header, and library files
used by your program. When you write a program in CodeWarrior, you first
create a project file and name it. Once created, you can add source files and
libraries to the project file.
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Metrowerks CodeWarrior uses the project information to control the devel-
opment environment so that it provides version tracking for the source
files. Let's say you edit two out of many previously compiled source files in
the project, and now want to create a new version of your application. The
project knows to compile only the two altered files, while linking in the
object code for the rest of the files. If you change a header file, the environ-
ment recompiles all of the source files which rely on that particular header
file. This version tracking keeps all of the project’s object code up to date,
yet it does so efficiently by compiling only those files that require it.

With that in mind, give the Toolbar some company by creating a project.
Select New Project... from the File menu. A Standard File dialog box ap-
pears. Type in a name, such as foobar, and press Return. A Project window
appears, as shown in figure 2.2

€ File Edit Search Project Tools Window 12 28 AM Cﬂ .

Code Data H ¥

0 file(s)

Figure 2.2 The foobar Project window

Looks pretty dull, doesn't it? That's because the Project window serves as a
snapshot of a program’s makeup. It normally displays a program'’s relevant
source code files and any libraries used to make the program. Along with
each source file and library filename is the size of the object code and data
created by these files and information about whether each file contains
segment and debug data. Because you've just created the project and
there's nothing in it, the Project window is empty.
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Liven up project foobar a bit. Go back to the File menu and select New. A
window opens. This window belongs to the built-in editor and is called the
Program window. To keep it simple, type in the C source to the well-known
“Hello world"” program (see figure 2.3). Now select Save from the File menu
to save this window as a file named hello.c.

1231aM (D B

#include <stdio.h>

void main{void)

{

printf ("Hello world\n");
} /% end main() */

I

OE [ El

Figure 2.3 A Program window with source code

Now you'll add “hello.c” to the project. As you might expect, the
Project menu has all sorts of commands that deal with projects. The Add
Window and Add File... commands add files to the project and the Remove
command takes them out of the project. The Compile command compiles
source code files and adds the resulting object code to the project, and the
Disassemble command disassembles object code files in the project. There
are also some version control commands to either remove all object files
(Remove Binaries) or make the object code of all modified source files
current by compiling them (Bring Up To Date). There's a Make command
that does a full-blown compile of all the source code files if required, and
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links the resulting object code and library files to create a Mac application.
A Build Library command gives you the option of linking your code to
generate a library file if you are distributing your own utilities or develop-
ment tools. Finally, the Run command performs a make operation on your
application and then launches it so that you can test it.

Back to adding “hello.c” to project foobar. Choose Add Window from the
Project menu. This places the open file in the Program window—in this
case, “hello.c”"—into the project. Now take a look at the Project window (see
figure 2.4).

EE==——== foobar
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Figure 2.4 The Project window with “hello.c” added

The file “hello.c” appears in a slot (the dotted lines) in the Project window.
Since the file has yet to be compiled, the sizes of the object code and data
are zero. Now pick Compile from the same menu (or from the Toolbar). The
built-in C compiler compiles the file. The Toolbar's status window will
briefly flash a message telling you it's compiling “hello.c” and the object
and data numbers will change. Select Run from the Project menu. The
linker links the code again (CodeWarrior takes no chances) and a Message
window appears (see figure 2.5).

The Message window shows errors and warnings detected by the compiler
and linker. It looks like we forgot a library, doesn't it? Go back to the Project
menu and add some libraries to the project. Use the Add File... command,
which presents a Standard File dialog box that you use to maneuver into
the ANSI folder and then into the Libraries folder. Choose the library file
“ANSI C.PPC.Lib.” (For a 68K Mac the path is the same, but choose
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“ANSI (2i) C.68.Lib.") Now the Project window shows two filenames. For a
68K Mac, you're done, but for a Power Mac you need to add several support
libraries. Two of these are located in the MacOS folder and then in the
Libraries folder. They are called “InterfaceLib,” and “MathLib.” In the C++
Runtime folder is a small bit of code called “MWCRuntime.Lib.” Again, use
the Add File... command to put these files into your project. The object code
for these files obviously hasn't been loaded into project foobar, because like
“hello.c” previously, the size of each file's code and data are zero. Select
Bring Up To Date from the Project menu and you'll see these numbers
change as the libraries load (see figure 2.6).

& File Edit Search Project Tools Window

22 (=] e Soh =)

G2 | |16 O | 1)

foobar

File Code Data B ¥
hello.c T 40, 211 . 0

hello.c

#include <stdio.h>
void main{void?

printf ("Hello world\n")>;
} /% end main () %/
B=————————————— Frror Window
®® Errors @ 3 ¢¢ Warnings : 0
®® |ink Error undefined: ‘_terminate’ (desc

®e Link Error : undefined: ‘_start’ (descriptor)

®® Link Error : undefined: ‘_initialize’ (descriptor)

Figure 2.5 The Message window displaying an error
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Eﬂﬁ foobar

File Code Data "3
ANSI C_PPC.Lib T82176] 14495] D)
hello.c {40 21; .- mE
InterfacelLib 0 0; m
MY¥CRuntime Lib i 3268i 487 0]
| Mathiib 00 o0 (5]
Ao
5 file(s) 83K 14K

Figure 2.6 The Project window with the source file compiled and libraries
added

Finally, you can choose Run from the Project menu and watch the program
run. To exit the program, select Quit from the application’s File menu. You'll
see a dialog box asking if you want to save foobar.A.out (which is the
contents of the screen). Click on the Don't Save button to discard the data
and return to CodeWarrior. You'll notice that the default name of the appli-
cation file just created was “foobar.A."” Later, in the preferences section of
CodeWarrior, you'll learn how to change the application's name. This was
obviously a simple programming example, but it should give you a feel for
maneuvering about in the CodeWarrior environment, setting up projects,
and creating a Mac application.

The Project window helps you manage the project’s files in various ways.
Double-clicking on a file's slot in the window makes the editor open that
particular file. If you click on the file's slot under the icon that looks like a
bug, a dot appears. This informs the compiler that you want the file com-
piled with debugging information. Next to the debug icon is a small rect-
angle with lines, called the segment icon. It indicates whether the file has
multiple segments. (You'll learn more about segments in a moment.) If you
click on the small boxed arrowhead (or triangle) icon for the hello.c slot and
hold down the mouse button, a small pop-up menu appears (see figure 2.7).

This pop-up menu shows what header files the compiler used while pro-
cessing this file's source code. Picking a filename from this menu opens the
header file for your inspection. At the top of this menu, a single menu item
appears that states either “Has to be compiled” or Touch. The “Has to be
compiled” item is just informative: you haven't compiled the file yet, or
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you've just made a change to the file that requires it be compiled again. As
a Touch item, you can choose it to inform CodeWarrior that you want the
file recompiled the next time the project is brought up-to-date, whether
you've changed the file or not. Note that once you've “touched” a file, you
can't unmark the file. For libraries, this pop-up menu will either state “Has
to be compiled” if the library isn't loaded, or Touch if it is loaded.

foobar

File Code Data H ¥
ANSI C.PPC Lib T 82176: 14495] o |
InterfaceLib 0;
M¥CRuntime Lib | 3268] 48] .4gions
MathLib 0; <yvals h>

MacHeaier sPPC

K84

5 file(s) 83K 14K L]

Figure 2.7 The pop-up menu for “hello.c” shows the header files used

On 68K Macs, you can click on the file slot in the Project window and drag
it about. If you drag the slot beyond the dashed line of the bottom-most
filename, you create a new segment (see figure 2.8). This allows you to
visually arrange your source files into the code segments you want; the
linker will handle the details of building the code segments when it creates
the application. You can also use the #pragma segment directive to define
segments in your 68K source code. If you do this, in the Project window a
dot appears under the segment icon in the file's slot, which indicates that
the source file has multiple segments.

EE=—— switch

File Code Data B ¥
1 Mac0S.Lib | 30790! GH D)
]
2 file(s) 32K 0K =]

Figure 2.8 Segmenting a 68K Mac program by dragging a filename
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/(‘ j

Background Info
\\‘/ / On 68K Macs, object code can be combined into chunks called segments.
Segments came about because early Macs required program code to be in
small pieces that could be brought into or removed from memory as required.
With 128K of RAM, the operating system had to shoehorn code into any spare
opening it could find in memory. These openings might appear at different
memory addresses as code was loaded and purged while the Mac application
ran. For this technique to work, program code can't use absolute addressing
schemes, but instead uses PC-relative addressing. PC-relative addresses are
calculated by using the current address in the Program Counter (PC), plus an
offset value. This enables the code to be position independent and loaded into
any part of memory. The size of these offsets for PC addressing was limited by
the classic Mac's 68000 processor to only 16 bits. (Actually, the processor used
a signed two’s complement value. The sign of the value pointed to the next
address's direction, relative to the PC. A positive value pointed forward to higher
addresses, while a negative sign pointed backward to lower addresses. Because
it was a signed value, only 15 bits were actually used for the offset value.) This
limited code segments to 32K in size. Later Macs used the 68020 and succes-
sive processors that had a 32-bit offset value, effectively removing the 32K size
limitation on segments. Nevertheless, for compatibility with 68000-based Macs,
and to operate efficiently within limited memory, most programmers still segment
68K Mac code. This isn't an issue for Power Macs, because pieces of 601 code,
called code fragments, can be any size. A Power Mac application is usually a
single code fragment, although it might obtain code or data from other code
fragments.

A

Figure 2.9 summarizes the Project window's functions.
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Click here to have debug A dot indicates the file
information added to object code _| |- has multiple segments

=ElM=—————— foohar

File Code Data|H ]
TR . o EHE— Click on triangle to get pop-
Double-click on the source —— | serfaceL i 6 B g up menu of header files
file to open it with the editor MathLib 0 o 5] and fo touch the source file
M¥CRuntime .o 516 0 O]
]
5 file(s) 58K OK |}

Figure 2.9 How to use the Project window to manage project information

The Editor

Since you'll spend most of your time entering and modifying source code in
the built-in editor, Metrowerks has added a number of features to make
your stay a pleasant one. Let's check out the editor by opening one of the
sample project files on the CD-ROM. Go to the FlipDepth folder and open
the file “Klepto.w.” After the Project window opens, double-click on a source
file slot Klepto.c to open the file with the editor. (Such filenames end with

a .c extension. You can't open a library or object file with the editor.) A
Program window appears, displaying the file's source code (see figure 2.10).

Two icons are in the bottom left corner of this Program window. The first
icon is a triangle, and looks similar to the one in the Project window. Sure
enough, if you click on it and hold down the mouse button, a pop-up menu
appears, containing the names of all the header files used by the file (see
figure 2.11).

You can scroll through the names and open the desired header file by
selecting a filename from the menu. The item at the very top of this Tri-
angle menu is either Touch or “Has to be compiled.” These items operate
the same way as in the Project window. The Triangle menu thus provides a
convenient way to access certain project management functions when a
Program window hides the Project window.
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€ File Edit Search Project Tools Window

InitGraf(&qd. thePort);
InitFonts();
FlushEvents{everyEvent, 0);
Initlindows();

InitMenus();

TEIni t();

InitDialogs<NIL);

/% Dpen the input file */
StandardGetFile(NIL, ONE_FILE_TYPE, shlbTupe, &inputReply>;
if CinputReply.sfGood>

GetUol C(NIL, &oldUol); /* Save current volume */
if ¢({fileError = FSpOpenDF (&inputReply.sfFile, fsCurPerm, &inFileRefNum>> != noErr)
{

SysBeep(30);
return;
} /% end if error *;

/% Open the output file */
StandardPutFile ("\pSave code fragment in:", fileName, &outputReply>;
if CoutputReply.sfGood>

SetUol (NIL, outputReply.sfFile.vRefNum); /* Make the destination volume current */
fileError = FSpCreate(&outputReply.sfFile, fileCreator, fileType, smSystemScript);
switch({fileError) /% Process result from File Manager */

case noErr:

break;

case dupFNErr: /* File already exists, wipe it out */
if ((fileError = FSpDelete(&outputReply.sfFilel) noErr)

BE] [Cre % [l

Figure 2.10 The Program window

The Braces icon next to the Triangle icon is another pop-up menu, called
the Function menu. When you click on the Braces icon and hold down the
mouse button, a pop-up menu appears and displays all of the C functions
the file uses (see figure 2.12). If you Option-click on this icon, the function
names appear in alphabetical order. A checkmark by the function’'s name
indicates that this function has the editor’s insertion point located in it. If
you pick a function name from this menu, the editor takes you to that
function, with the first line of its source code appearing at the top of the
Program window. This is very handy when you're tracking down a Toolbox
routine and happen to know the name of the function that uses it. Note that
the editor’s insertion point doesn't move when you jump around the file this
way. To avoid editing mishaps, be sure to click on a source line when you
land in the desired function.
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InitGrafi&qd. thePort);
InitFonts();

FlushEvents(everyEvent, 0);
Jan: 3110l -

Touch

<ConditionalMacros.h> |
<Controls.h>
<Dialogs h> le */
<Errors.h> NIL, ONE_FILE_TYPE, shibType, &inputReply>;
<Events.h> fGood >

<Files.h>
<rixe:13th,h> &oldVol ); /% Save current volume */

<Fonts.h> br = FSpOpenDF (&inputReply.sfFile, fsCurPerm, &inFileRefNum>> != noErr)

<IntlResources.h> B0 );
<Memory.h>
<Menus.h> if error */
<MixedMode .h>
<0SUtils h> i le */

<QuickDraw .h> i le ¢"\pSave code fragment in:", fileName, ZoutputReply);
<QuickdrawText.h> bly.sfGood)

<Resources.h> . 3
<Seript.h> IL, outputReply.sfFile.vRefNum); /* Make the destination volume current #*/
<SegLoad.h> = FSpCreate(&outputReply.sfFile, fileCreator, fileType, smSystemScript);
<Standart'iFiIe hs i |eError) /* Process result from File Manager */

<TextEdit.h>
<TextUtils.h>

1<)
<ToolUtils.h> dupFNErr: /% File already exists, wipe it out */
<Traps.h> if ((fileError = FSpDeletel(ZoutputReply.sfFiled) == noErr)

hoErr:

<Types.h>
<windows.h>

Figure 2.11 The Triangle pop-up menu presents a list of header files used by
the file

The editor also has a comprehensive set of search functions that let you
locate something by name. For example, if you know only the routine
name, pick Find... from the Search menu. A Find window appears, where
you can type in the routine name (see figure 2.13). You can search multiple
files, such as the header files or the source files in your project. You can
perform a search on a name and replace it with another name, an action
called search and replace. It's valuable when you want to replace all
occurrences of, say, the Toolbox routine NewWindow () with NewCWindow () in
your program.
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® File Edit Search Project Tools Window

R SR fEINEY

InitGraf(&qd. thePort);

Ini tFonts();
FlushEvents(everyEvent, 0);
Ini tlindows();

InitMenus();

TEInit();

InitDialogs(NIL);

/% Open the input file */
StandardGetFileCNIL, ONE_FILE_TYPE, shibTupe, %inputReply);
if CinputReply.sfGood)

GetUol (NIL, &oldVol); /% Save current volume */
if ¢((fileError = FSpOpenDF (&inputReply.sfFile, fsCurPerm, &inFileRefNum)) != noErr)

SusBeep(30);
return;
} /¥ end if error */

/* Open the output file */

StandardPutFile ("\pSave code fragment in:", fileName, &outputReply>;
if CoutputReply.sfGood)>

SetUol(NIL, outputReply.sfFile.vRefNum); /% Maoke the destination volume current */
fileError = FSpCreated&outputReply.sfFile, fileCreator, fileType, smSystemScript);
switch(fileError) /* Process result from File Manager */

case noErr:

break;

case dupFNErr: /* File already exists, wipe it out */
if ({fileError = FSpDeletel&outputReply.sfFiled) == noErr)

Move_Fork
[V main
)

Figure 2.12 The Function pop-up menu lists all of the file's functions

EE fid ==
Find: NewllJindouJ(I [ Ignore Case
[ Entire Word
Replace: [J] Wrap Around
[JRegexp

Multi File Search

[]Stop At EOF ( Project Sources Repiaxa Al
= (Project Headers Aeplace & ﬁi’i(?l

= ( Claar J[[[ Find )|

Figure 2.13 The Find window
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Further along the bottom of the Program window, past the Triangle and
Function pop-up menus, is an area that indicates the editor insertion point’s
location by displaying the appropriate source code line number. If you click
on this area, the Go To Line Number dialog box appears (see figure 2.14).
When you enter a new line number here and click on the OK button, the
editor insertion point and the Program window display are moved to the
desired line. This go to capability is helpful when the Message window
gives you an error message with a line number. A useful shortcut that
jumps you to the problem source line is to double-click on the error mes-
sage in the Message window.

Go To Line Number:

=)

Figure 2.14 The Go To Line Number dialog box

1
|
|
i
:
?
i

Keyboard mavens can maneuver through the source code using the arrow
keys. Move the editor insertion point one character left or right using the
Left and Right Arrow keys and one line up or down using the Up and Down
Arrow keys. Using the Option key with the Left and Right Arrow keys
moves the insertion point left or right by a word. If you use the Command
key with these arrow keys, the insertion point is placed at the start or end
of aline. When you use the Option key with the Up and Down Arrow keys,
you move the insertion point up or down one “page,” or screen, of text. The
Command key, when used with these keys, moves the insertion point to the
beginning or end of the file.

If you have a color monitor, you can set the colors of the C language key
words (the default is blue) and of the comments (the default is red) in the
source code. Coloring the key words helps you quickly spot a particular key
word as you scroll through the code. Coloring the comments helps you
identify chunks of source code peppered among lengthy comments in the
file. (You are going to comment your code a lot, right?) It also helps you
spot those early morning coding gaffes where you accidentally forget to
close a comment and thus inadvertently comment out dozens of lines of
source code.
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The editor automatically scans your code as you enter it, watching to see if
you balance your bracket characters. Bracket characters consist of the
parentheses (), the square brackets [ |, and the braces { }. If you add a
surplus right bracket character, the editor triggers an alert sound. You
should note that this scan function operates only after the source code is
saved to a file and that surplus left brackets are not detected. If you don't
like the editor beeping at you, this feature can be disabled with the Prefer-
ences... command. Finally, if you need to know where the file you're editing
is located on the Mac's hard drive, press the Command key and click on the
Program window's title bar. A pop-up menu shows the complete pathname
of the open file.

Figure 2.15 summarizes the features of the Program window.

Command-click here to display this file’s pathname

P11, —————————

MoreMasters();
MoreMasters();
MoreMasters();
MoreMasters();

InitGraf(&qd. thePort);
InitFonts();
FlushEvents(everyEvent, 0);
Initlindows();

InitMenus();

TEIni tC);

InitDialogs(OL>;
InitCursord);

initStatus = TRUE; /* Assume successful setup (for now) *;
for (i = APPLE_MENU; i <= LAST_MENU; i++)

myMenus (il = GetMenudid;

if (myMenuslil == NIL>
return FALSE;

}; /* end for *7

AddResMenui(myMenus [APPLE_MENU1, 'DRUR'>; /% get DR */

for (i = APPLE_MENU; i <= LAST_MENU; i++)
InsertMenudmyMenus(il, 0);
DrawMenuBar();

ifC!Init_AE_Events()> /% Set up our high-level event handlers *;
return FALSE;
Get_Depth(); /* Get machine's video info, load variables, and setup */
/%  Periscope menu */
return initStatus;

Click here to jump to a new line
The Function menu displays the functions in the file
The Triangle menu displays the header files used by this file

Figure 2.15 Features of the Program window
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The Compiler and Linker

The built-in C compiler is unobtrusive. It doesn't have windows like the
built-in editor, yet at the click of a button or keystroke, you summon it to
compile your source code. On large projects, you'll see status messages in
the Toolbar that indicate it's busily processing header and source code
files. If your code passes muster, values change in the Project window. If
not, the compiler opens the Message window and drops error and warning
messages into it. Ditto for the linker: It quietly does its job and either an
application file pops into existence or warnings appear in the Message
window. This isn't to say these two tools in the IDE aren't important.
They're absolutely crucial to generating the end result, the finished Mac
application. Because the project file keeps track of all the relevant informa-
tion—source files, header files, libraries, and whether these files are cur-
rent—all the compiler and linker really have to do is the follow-up work of
translating source code into object code and linking the object code into an
application file.

Nevertheless, there are situations when you want to exercise control over
what the compiler and linker do. For example, you might want to generate
code for a shared library instead of an application, or have the linker add
debug symbols into the resulting application. But if the compiler and linker
have such low profiles, how do you get at them to change their behavior?
You do this through the Preferences settings. Since these Preferences also
touch on the operation of other parts of the IDE we'll briefly review all the
preference settings.

Preferences

Start by selecting the Preferences... command from the Edit menu. The
Preferences dialog box appears (see figure 2.16). In the left side of the
window is a scrolling list of icons. Each icon represents a certain portion, or
group, of the environment. Select the group whose settings you want to
change by scrolling through this icon list with the mouse and clicking on
the group's icon. Each group has a unique panel in the Preferences window
that controls a number of adjustable settings. Figure 2.16 shows the panel
for the Font group.



@ Power Macintosh Programming Starter Kit

Apply to open project.

- Font & Size Info:
Font: | Monaco v

Size: [ 9 v |

| program therefore | am.

Editor

X Ruto Indent Tab Size:

i

Processor

(Factory settings]  (Revert Panel] [ Cancel )

Figure 2.16 The Preferences window, showing the Font group panel
settings

At the window's bottom are four buttons: Factory Settings, Revert Panel,
Cancel, and OK. They operate as follows:

B The Factory Settings button takes all the settings of the chosen group
and restores them to the default values suggested by Metrowerks.
You'd use this button if you suspected that one of the group settings
you changed might be causing a problem.

B The Revert Panel button undoes any changes you made to a group's
panel. Unlike the Factory Settings button, Revert lets you preserve the
current group settings. For example, say you've already got your
custom Linker group preferences set up properly. You happen to be
examining the Linker group panel and accidentally click on a
checkbox. Revert discards the last change, without wiping out the rest
of the settings.

B The Cancel button closes the Preferences window without saving any
changes you made to a group's settings.

B The OK button saves the changes you made to the group settings and
closes the Preferences window. You can make changes to one group
and scroll to another group panel to make changes before clicking on
the OK button. For certain groups, you get an alert window warning
you that to use these new settings, you have to recompile or relink the
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project’s files. The Factory Settings and Revert buttons dim or undim
depending upon whether the current group preferences match that
button's settings.

Let's complete our tour by examining each group's preference settings. In
figure 2.16, the Preferences window displays the Font group’s current
settings. This adjusts the font used in the Program window. One pop-up
menu selects the font while the other pop-up menu selects the size.

The Editor preferences, as its name implies, adjusts the built-in editor (see
figure 2.17). Change the color of comments or keywords by clicking on their
respective color bar in the panel. This action opens the Color Picker win-
dow, where you select another color. The Dynamic Scroll checkbox deter-
mines how text scrolls when you move the scroller (or thumb) on a Pro-
gram window. Save All before “Run” determines whether all modified
source files are automatically saved before CodeWarrior builds and
launches your application. It's a good idea to check this setting since the
application might cause a crash severe enough to force you to restart the
Mac—you'd like to have the last file changes saved to disk in this situation.
The Remember settings tell the editor how to precisely reproduce the
Program window when you open a file. The Projector Aware setting is for
use with Apple’s Projector, a version control application.

Apply to open project.

- Color Info:
[X] Color Syntax

Comments:
Key Words:

[ Dynamic Scroll [X] Save All before "Run”

- Remember:
[ Font Preferences

X Window Position And Size
(<] Selection Position

[X] Balance While Typing X Projector

Processor Flashing Delay: Aware

(Factory Settings]  (Revert Panel] [ Cancel ] 0K

Figure 2.17 The Editor preferences group
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The Language preferences group determines how the compiler handles
your source code (see figure 2.18). The Source Model pop-up menu lets you
select Custom, ANSI C, ANSI C++, Apple C, or Apple C++ (the latter two
settings allow for language extensions added by Apple to support the Mac
Toolbox). The appropriate Language Info options are checked automati-
cally when you make a choice from this pop-up menu. The Custom setting
is selected when you pick Language Info settings that don't provide com-
patibility with the ANSI standard. The Prefix File option lets you select or
deselect a file that contains a precompiled set of header files. The default is
MacHeadersPPC (or MacHeaders68K), which is a Metrowerks-supplied file
with a subset of precompiled System 7 header files.

Apply to Metrowerks defaults.

Source Model:
- Language Info:
[ Activate C++ Compiler
[J ARM conformance
[JANSI C/C++ Key Words Only
[ Require Function Prototypes
[J Expand Trigraph Sequences
[J Enums Always Int
[] Enable MPW) Pointer Type Rules

[Factory Settings]  (Revert Panel] (Cancel ] [ 0K

Figure 2.18 The Language preferences group

The Warnings Info group lets you set how strict or lax the compiler is with
the language (see figure 2.19). Depending upon the settings you make, the
compiler can ignore the vagrancies of code written at 2 AM, or notify you of
“dead code” (that is, code that's not used by the function). I prefer to check
the Extended Error Checking item, as it provides a modest amount of
sanity checks on my program code.
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Apply to Metrowerks defaults.

- Warnings Info:
[J 1negal Pragmas

[J Empty Declarations
[ Possible Errors

[ Unused Variables
[J Unused Arguments
[J Extras Commas

X Extended Error Checking

Editor

Language

g@
|

(Factory Settings)  (Revert Panel] [ Cancel ]

Figure 219 The Warnings preferences group

The Processor preferences group is shown in figure 2.20. The Power
Macintosh settings are displayed. The Struct Alignment pop-up menu lets
you pick 68K, 68K 4-byte, or PowerPC memory alignment for the data struc-
tures used in your program. Use the first two settings if you plan to make an
application to run on both Power Macs and 68K Macs. Make String Literals
ReadOnly determines whether character strings are stored in the program
code (which are marked read-only in code fragments). The Generate Profiler
Calls has the compiler generate code that supports code tracing for the
purpose of measuring a program's performance. The other options adjust
optimization settings. The Optimize pop-up menu tells the compiler to
optimize for size or speed. On a 68K Mac, you'll have a different Preferences
panel where you can set optimizations and designate what type of proces-
sor code is generated (68000, 68020, and 68881 floating-point instructions).

The Linker preferences group determines how Power Mac code is linked
(see figure 2.21). The Link Options settings determine whether symbol table
and address map files are created (which are useful for debugging), supress
warning messages (necessary for certain types of code), and whether the
linker operates out of memory. The Entry Points settings are for the code
fragment’s initialization function, its main() function, and a completion
function. You'll typically leave these settings alone. The 68K Mac linker
group panel lets you add debug information to the executable code, gener-
ate symbol table files, and indicate whether or not you want to create multi-
segmented code.
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Apply to Metrowerks defaults.

Struct Alignment: | 68K -]

[JMake String Literals ReadOnly
[] Generate Profiler Calls

Optimizations:
O Instruction Scheduling
[ Global Optimization

Peephole Optimization

optimize for:

(Factory Settings]  (Revert Panel] (Cancel ] [ 0K |

Figure 2.20 The Processor preferences for a Power Mac

The PEF (Preferred Executable Format) preferences group panel (see figure
2.22) determines whether or not the code fragment that makes up your
application exports symbols and shares code or data. The default settings
in the pop-up menus are for a typical Mac application, and like the PEF
group, just leave them alone for now. The 68K Mac version of CodeWarrior
doesn't have a PEF group at this time.

Apply to Metrowerks defaults.

r Link Options:
X Generate SYM File
X Use Full Path Names
[J Generate Link Map
[ Suppress Warning Messages
X Faster Linking (uses more memory)

(Entrg Points:

Initialization: | _initialize l
Termination: | _terminate |

[Faclorg Settings] [Heuert Panel [Canceﬂ

Figure 2.21 The Linker group preferences for a Power Mac
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Apply to Metrowerks defaults.

Processor

Export Symbols: | None v |

Dersion Info:

o1d pefinition: | EEGGEE
0ld Implementation: |0

Current Version: | 0

[J Order Code Section by #pragma segment
[J Share Data Section
[] Expand Uninitialized Data

ro ject

(Factory Settings]  [Revert Panel] [ Cancel

Figure 2.22 The PEF group preferences for a Power Mac

The Project preferences group panel (see figure 2.23) is where you'll spend
most of your time. Here's where you set the type of code you generate
(Application, Shared Library, Code Resource, or Library) in the Project Type
pop-up menu. This is also where you set the creator and type of the result-
ing file produced by the project and choose its name. Finally, you indicate
the amount of memory the application requires and its SIZE flags using the
SIZE Flags pop-up menu. The operating system uses the SIZE flags to
determine what sorts of events the application responds to and whether it
can operate in the background. Some special-purpose applications, such as
File Sharing, can only operate in the background and there's a special flag
for that here as well.

Finally, the Access Paths group settings, as shown in figure 2.24, let you
select additional folders for the compiler and linker to search. They nor-
mally only search the Metrowerks folder and your project folder for any
header, source, and library files. Access Paths lets you redirect the search
path of these tools to other folders when looking for project files. This is
handy in situations where certain project files might be located on a server
for version control. To do this, click on the Add button and use the Standard
File dialog box to navigate and select other folders. The Change button lets
you alter existing search paths and the Remove button deletes folders from
the search path.
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Apply to Metrowerks defaults.

Project Type: | Application |

- Application Info:

File Name |Coolfpp |

Creator | 2227

Type |APPL

Preferred Heap Size (k) |384

Minimum Heap Size (k) (384
Stack Size (k) |64

'SIZE' Flags

(Factory Settings)  (Revert Panel] [ Cancel ]

Figure 2.23 The Project preferences group for a Power Mac

Apply to open project.

*] rAdditional Access Paths:
O
=
: &l [
n i
Projest [ (_Add ] [change ] [Remouve]

[JTreat #¥include <...> as #include "...".

(Factory Settings]  (Revert Panel] [ Cancel

Figure 2.24 The Access Paths group preferences

The Tour’s Over

In this chapter we've looked at some of the features of CodeWarrior's IDE.
We've even run the “Hello world” program, to see how you build a project,
and ultimately an application, in CodeWarrior. This tour has not covered all
of the features Metrowerks CodeWarrior has, but it has touched on the
significant ones. We'll use this knowledge to build a practical C application
on the Power Macintosh—starting in the next chapter.



Beginning Programs

This chapter is for the novice programmer. It shows you how to
use the ANSI C Standard Libraries supported by the
Metrowerks C compiler to do simple tasks on the Mac. The
interface for these programs won't be pretty, given that the
ANSI Libraries stem from UNIX's character-based heritage. The
goal here is not appearance, however, but function. These
libraries provide a safety net that you can rely on as you explore
the Mac's Toolbox and operating system.

As an aspiring Mac programmer, you've no doubt heard this
often-quoted maxim about the Mac: “Easy to use, hard to
program.” Why is this? If you've already leafed through the half-
dozen or so volumes of Inside Macintosh, you may even know
the answer to that question.

Out of this wealth of information, where do you
start? Put another way, how do you determine
which Toolbox calls to use when starting an
application and
which ones to call
in order to access
services provided
by the operating
system?
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About the Toolbox

The Mac Toolbox and operating system provide over four thousand rou-
tines at your disposal, of which about several hundred are commonly used.
The Mac is a complex gestalt of these routines and data structures that you
must understand fairly well in order to write a program. How do you know
which routines to use? After all, you must understand how to initialize the
application’s environment so that these routines function, how to plug the
application into the operating system so that it coexists and cooperates
with fellow applications, and last, but not least, how an event-driven inter-
face works. This seems like a rather dismal attitude to take for a book on
Mac programming, but I'd rather you appreciate that there's a lot to learn
just to get started in Mac programming, than get frustrated and give up
entirely.

Background Info

So that we won't get confused later when | start talking about calling functions,
we'll make a distinction between those functions our program uses, versus those
belonging to the Mac Toolbox/OS. Following /nside Macintosh conventions, I'll
use the term routine to indicate Toolbox functions.

Having said that, now I can say it's not impossible to learn how to program
the Mac. The trick is to limit the unknowns you're dealing with so you can
break the job into smaller, manageable portions. Fortunately, Metrowerks
CodeWarrior itself provides a way to limit the problems you face, as you'll
see in a moment. Another way to deal with some of the unknowns is to
have plenty of source code examples handy. This way you can learn how
particular routines operate and when to use them. I'll help you here by
supplying some working code examples.

Munge It

I firmly believe in learning by doing, so let's start by solving a problem. One
of my jobs as a technical editor is to take manuscripts and edit them. I
clarify certain points in the manuscript, reorganize the flow of thought,
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request missing material, and perform other editorial tasks. I receive these
manuscripts as ASCII text files sent via electronic mail (E-mail) on the
Internet or other online services. Ideally, I get a manuscript file and simply
start editing it in a word processor. In reality, sometimes there are prob-
lems.

Most word processors, both Mac and PC, use a carriage-return (CR) charac-
ter to end a paragraph of text. This allows the word processor to neatly
“wrap” or fit the text on the screen as you add or eliminate words inside the
paragraph. However, some word processors save the text with CRs at the
end of each line. The text looks fine—until you have to change the manu-
script using a different word processor. Because of the extra CRs, the word
processor can't wrap the words, and you wind up with a mass of jumbled
text. The author probably meant well, but the editor now has to laboriously
prune those spare CRs from the text, line by line. This type of file is a head-
ache for me to edit.

After hacking away at one long manuscript for over an hour, I decided that
this chore was a great job for the Mac to handle. I'd write a Mac program to
munge, or hack out, those extra CRs for me. Basically, the program would
read an input file, filter out most of the CRs, and write the rest of the data to
an output file. Thinking more along the lines of how the computer has to do
it, the program reads a byte—or character, actually—from the input file,
examines the byte, and if it passes muster (it's not a CR), writes the byte to
an output file. If the byte is a CR, it's tossed into the bit bucket instead. If
the program detects the end of a paragraph (a double CR, or a blank line),
then the end of paragraph (the double CR) is written to the output file. This
makes the resulting output ASCII text organized the way a word processor
expects it. Stated this way, the problem seems easy enough.

Now here's where CodeWarrior helps. Metrowerks CodeWarrior supports
the ANSI C Standard Library, which is based on the UNIX C function
libraries. These libraries supply functions that handle file I/O and provide
an interactive console where you enter commands and get screen output.
Since these functions were originally implemented on old UNIX systems,
they typically deal with character-based I/0. This doesn't make for a nice
Mac interface, but it lets you concentrate on the problem without having to
learn lots of Toolbox routines all at once.
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|

Important

CodeWarrior's console I/0 provides support for the C Standard Library's stdin,
stdout, and stderr streams. It opens a virtual console window where all these
streams are directed. The console window is set up and managed by
CodeWarrior's SIOUX (Simple Input/Output User eXchange) library, which is
automatically linked to an application when you add the ANSI C library (ANSLIib)
to the project.

’=

Getting Started

Let's get started by launching the CodeWarrior C compiler. The easiest way
to do this is go inside CodeWarrior folder, open the Code Exampiles f folder,
followed by the Munger f folder, and double-click on the file “munger.c.”
CodeWarrior launches, and you should see the following code:

#include <stdio.h>

#define CR 0x0D
#define LF Ox0A

FILE *istream, *ostream;

void main (void)

{

short crflag;

long icount, ocount;

char ifile[64], ofile[64]; /* Path names must be 64 chars or less */
int nextbyte;

printf ("Enter input file: ");
gets (ifile);

if ((istream = fopen(ifile, “rb")) == NULL) /* Open the file OK? */
{
printf ("\nError opening input\n®); /* NO, say so */
return; /* Bail out */

} /* end if */
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printf ("Enter output file: *);
gets (ofile);

if ((ostream = fopen (ofile, "wb")) == NULL) /* Can we write an output file? */
{
fclose (istream); /* NO. First close input file */
printf (“\nError opening output\n®); /* then warn, and bail out */
return;

} /* end if */

icount = OL; /* Set counters */
ocount = OL;
crflag = 0;

/* Read char.s until end of file */
while ((nextbyte = fgetc (istream)) != EOF)

{
icount++; /* Bump input char counter */
switch (nextbyte) /* What char was read? */
{
case CR:
if (crflag >= 1) /* Two in a row, end of paragraph */
{
fputc(nextbyte, ostream); /* Write two CRs to the output */
fputc(nextbyte, ostream);
crflag = 0; /* Reset the flag */
ocount++;
} /* end if */
else
crflag++; /* Bump the flag, and toss the CR */
break; /* end case CR */
case LF: /* Toss LF, but don't touch crflag */
break; /* end case LF */
default:
fputc (nextbyte, ostream); /* All other char.s get written */
ocount++;
crflag = 0; /* Clear the flag */

} /* end switch */
} /* end while */
fclose (istream); /* Clean up */
fclose (ostream);
printf ("Bytes read: %ld\n", icount);
printf ("Bytes written: %ld\n", ocount);
} /* end main () */
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Let's take a closer look at this code.

The Code Tour

The munger program first prompts for an input file name, using the printf()
function to put a message in a console window made by the C Standard
Library. It uses gets() to read the keyboard when you type in a filename and
press Return. Your input is placed in the array ifile. Note that ifile and ofile
are sixty-four characters long. If you're opening files with either long
names, or the file is in a folder with a long name, you need to increase these
array sizes so that the pathname fits.

Background Info

A pathname is the complete description of the directory path used to locate a
file. For example, if the Mac's hard drive is named Tachyon, and a file “Read
Me" is in the folder New Info f, the pathname for the file is Tachyon:New Info
f:Read Me. This convention is similar to DOS/Windows pathnames, but instead
of a backslash (\), the Mac OS uses colons as separator between the drive,
folder, and filenames. This is also why you can't use a colon in a filename.

Next, the program uses fopen () to open the file:

if ((istream = fopen(ifile, "rb")) == NULL) /* Open the file OK? */
{
printf (“\nError opening input\n"); /* NO, say so */
return; /* Bail out */

} /* end if */

Note that we check to see if this open operation fails. If it does fail, the
program halts. With the minimalist input provided by the C Standard
Library, it's quite possible for you to mistype the filename, which creates an
error condition when fopen () fails to open the file. The program then uses
similar code to set up the output file and checks for trouble as it does so.
This is a good time to emphasize that no matter how simple or complex
your program is, always, ALWAYS, ALWAYS, check for errors. You can
eliminate a lot of crashes, trashed hard disks, and needless debugging by
having your program determine if the routines it calls complete success-
fully.
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The heart of the program is the while loop, which reads a stream of bytes
from the input file and processes them. The switch statement inside the
loop determines the fate of the byte under scrutiny. Any character other
than a CR or linefeed (LF) falls through to the default case, which writes the
character to the output file. Since I get lots of files from PCs, and DOS ASCII
text files use a LF-CR combination to end each line, the program also filters
out any LF characters it happens to find in the character stream. The
program handles this filtering operation with the LF case statement, which
simply does nothing, and as a consequence the LF never gets written to the
output file.

Now to those CRs, which are handled by the case statement:

case CR:

if (crflag >= 1) /* Two in a row, end of paragraph */
{
fputc(nextbyte, ostream); /* Write two CRs to the output */
fputc(nextbyte, ostream);
crflag = 0; /* Reset the flag */

ocount++;
} /* end if */
else
crflag++;
break; /* end case CR */

~

* Bump the flag, and toss the CR */

The program logic works on the assumption that most folks separate
paragraphs with a blank line. This means that the last line of the paragraph
ends with a CR, which is followed immediately by a blank line composed of
a second CR. So when the program encounters the first CR character, it
gets tossed into the bit bucket and the flag crflag is incremented. If a
character other than CR is read next, the program clears crflag. This
handles situations where the CR just terminates a line of text. Notice the
exception here: A LF character doesn't reset crflag, since it occurs jointly
with the CR in DOS files. When a second CR in a row occurs because of a
blank line, the if statement detects that crflag is set. The code now writes
two CRs to the output file to ensure the line break between paragraphs. Of
course, we clear crflag to begin the search for the next paragraph ending.

Finally, the program closes both files and writes a summary to the console
window of the bytes read and written, as tallied by the counters icount and
ocount. Since the program's function is to throw away bytes, fewer bytes
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should have been written than read. It's not necessary to do this, but the
summary serves as a sanity check on the program's operation, which is
reassuring to me. It's possible to defeat the paragraph detection logic by
submitting an ASCII text file with no blank lines between each paragraph,
but I can add thirty to seventy blank lines to a manuscript within minutes,
while manually stripping CRs from over several hundred lines takes up to
an hour.

(

Important

This text was written using the full version of Metrowerks CodeWarrior. You'll
have to use slightly different steps when using the limited version on the CD; the
limited version can only work with the sample files provided on the CD so the
commands Add File... and New Project are not available.

*=

So, if you are following along using the limited version of CodeWarrior that's on
the CD, when the text tells you to use the New Project or the Add File... com-
mand, you should instead open the related project file and keep it open
throughout the exercise. All the associated files will already be in the project so
you won't need the Add File... command. Then, you can follow the same proce-
dures as if you were using the full version of CodeWarrior.

Making Munger

Let’s make this file munging program. We've opened the file “munger.c,” so
the next step is to make a project for it. From the File menu, select New
Project..., type Munge.n (you get the mt character by typing Option-P) for the
project name into the Standard File dialog box that appears, and press
Return. There's an informal convention where you denote a project file by
attaching either a .7t or .prj extension to the name. This naming convention
isn't required, but if you're working with other programmers or plan to
share code with other users, it helps identify the project file for them. Now
choose Add File... from the Project menu. In the Standard File dialog box
that appears, locate the file “munger.c” and click on the Add button (see

figure 3.1).
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ity = Tachyon

Eject
Desktop

|- Add all
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Select files to add...
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=
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Figure 3.1 Adding “munger.c” to a project

The Add button dims, and next you click on the Done button. The source
file “munger.c” is added to project Munger.n. Since we're adding files to the
project, let’s finish up by adding the library files. Again, using Add File...,
select the files “InterfaceLib,” and “MathLib,” from the path
CodeWarrior:MW C/C++ PPC f:MacOS f:Libraries f, “MWCRuntime.Lib"
from the path CodeWarrior:MW C/C++ PPC f:C++ Runtime f, and “ANSI
C.PPC.Lib" from the path CodeWarrior:MW C/C++ PPC f:ANSI f:Libraries f.
Once you've collected all these files, click on the Done button and these
files appear in the Project window (see figure 3.2).

P Munger.®

File Code Data [ 3
InterfacelLib H 0: <7
MathLib 0 0} Bl

. . ol
MYCRuntime Lib 0} 0
ANSI C.PPC.Lib 0} 0} O]

hd

5 file(s) 0K 0K |]

Figure 3.2 Adding the library files to project Munger.m
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We're not done yet. Select Preferences... from the Edit menu. Scroll to and
click on the Language group icon. In the panel that appears, click on the
checkbox for Require Function Prototypes (see figure 3.3). This setting
demands that you declare each function, specifying the function's number
and type of input arguments and the type of the result (if any). This can
catch potential problems that can occur when you call the function with a
set of arguments different from what it expects. This might happen be-
cause you're modifying the function, or inadvertently passed the function
an argument of the wrong type, as when you call a Toolbox routine. In
either case, checking Require Function Prototypes nails this error at com-
pile time. Otherwise, when the program runs, such improper function calls
might cause a crash. I also delete the MacHeadersPPC precompiled header
filename from the Prefix File Item. This is because my work often involves
parts of the Mac OS that aren’t normally in the precompiled header file.

Apply to open project.

Source Model:| AppleC W

r Language Info:
[ Activate C++ Compiler
] ARM conformance
[J ANSI C/C++ Key Words Only
X Require Function Prototypes
[J Expand Trigraph Sequences
[ Enums Rlways Int
[J Enable MPW Pointer Type Rules

(Factory settings]  (Revert Panel] [ Cancel

Linker

Figure 3.3 Setting the Language preferences for project Munger.n

Next, go the the Warnings group and click on Extended Error Checking.
Like Require Function Prototypes, we actually don't need this setting for
this project, but since both enforce good programming practices, you ought
to get into the habit of setting them now. Extended Error Checking uses
stricter rules when compiling the C code, flagging code goofs such as
unused variables.
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Now scroll to the Linker group icon and click on it. In this group’s panel, go
to the Entry Points section. We're just going to check the default functions
that get called when our program initializes, starts, and exits. These func-
tions, which are part of the Power Mac run-time architecture, get called
when a native program launches and quits. For the Initialization item in this
panel, you should see the __initialize function name. The Main item has a
function name of __start. This function is responsible for calling our
program’s main() function. The Termination item (see figure 3.4) has the
function name __terminate. For typical C programs, __initialize and
__terminate do nothing. For C++ programs, __initialize sets up any static
C++ program's objects, while __terminate destroys these static C++ objects.

Finally, go to the Project panel and type Munger for the application name
into the File Name text box (see figure 3.5) and click on the OK button. Click
on the Toolbar's Make button or select Make from the Project menu, and let
CodeWarrior go to work on the project. If there are no problems, processing
statements from the compiler and linker briefly appear in the Toolbar’s
status area. An application named Munger is created.

Apply to open project.

rLink Options:
X Generate SYM File
X Use Full Path Names
[J Generate Link Map
[ Suppress Warning Messages
X Faster Linking (uses more memory)

- Entry Points:
Initialization: | _initialize
Termination: | _terminate

(Factory Settings] [Revert Panel] [ Cancel )

Figure 3.4 Setting the Termination entry point for the project



Power Macintosh Programming Starter Kit

Apply to open project.

Project Type: | Application v|
- Application Info:

File Name |munger | |

Creator | 2777
Type (APPL
Preferred Heap Size (k) 384
Minimum Heap Size (k) |384
Stack Size (k) |64

'SIZE' Flags

Access Paths |

(Factory Settings]  (Revert Panel] [ Cancel 0K

Figure 3.5 Setting the name of the application file that the project makes

Running Munger

Suppose that on a Mac hard drive named Tachyon, in the CodeWarrior
tools folder called CodeWarrior f, that there's a folder named Code Ex-
amples f, followed by a folder named Munger f. Inside it is a text file called
“PowerPC.txt.” Suppose “PowerPC.txt" is loaded with surplus CRs. First,
open the file in MacWrite Pro and examine the file with the Show Invisibles
set in the View menu. Show Invisibles displays all the characters in the
file—including invisible control characters such as CR—instead of just text
characters. In figure 3.6, you can see that each line ends with a small bent
arrow symbol; they represent CRs. If you don't have MacWrite Pro, don't
worry: other word processors can also display such “invisible” characters.
Check the documentation for your word processor for details how to do
this.
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& File Edit Font Size Style Format Frame Uiew

EE==——————— PowerPC.txt (Converted)

IBM-and-Motorola-announce first-silicon-on-PowerP C-603 I
ol

Atthe Microprocessor-Forum today-1Bm-and Motorola-jointly-+
announced the first fabrication-of the second-PowerPC-RISC-+
microprocessor, the-603. Thiswas-achieved-less-than-12.4
months-afterannouncing-initial-silicon-onthe-PowerPC-601.-+
The-PPC-603-provides-high-performance while-consuming-little-«
power, making-it-ideal for-notebook computer-designs .+

d

The-PPC-603-uses-3.3Y,-0.5micron, 4-level metal, static -«
CMOS technology to pack-1.6milliontransistors-onto-a die-«
that's-7.4-mmby-11.5mm.-By-contrast, the PPC-601-uses-3.6-«
¥,-0.6:micron-static-CMOS to-place-2.8-milliontransistors-on-a-«
die-120-mm-square.Like the-PPC-601,the-PPC-603-«
implements-a-32-bitversion-of the-64-bit-PowerPC-«)

architecture, with-a-32-bitaddress bus-and-a-32--or-64-bit-data-«
bus.-lt-uses the same-superscalar-design-with-3-instruction-«
dispatch.-However, the-PPC-603-does differfromthe-PPC-601-d
in-several-areas. First,the PPC-603-uses-a-Harvard-architecture -«
it-has two separate 8-KB-caches,-one for-instructions, and-one-+«
for-data.-Each-cache-has-its-ownMMU.-Both caches-are two-«

ool

Figure 3.6 A sample text file, with CRs at the end of every line

It's time to set “munger” to work on this file and see what happens. Launch
“munger” from Metrowerks CodeWarrior by clicking on the Run button in
the Toolbar. A console window called munger.out appears. Type in the
pathname to the sample text file we examined earlier as follows:
Tachyon:CodeWarrior f:Code Examples f:Munger f:PowerPC.txt. Of course,
if your hard drive name and CodeWarrior tools folder are named differently,
you'll type in the appropriate names into the pathname. If you goof on the
filename, “munger” complains and the program stops. If the filename is OK,
“munger” asks for an output filename. Type in a filename that uses the
same file path, such as Tachyon:CodeWarrior f:Code Examples f:Munger
f:PowerPC.out. Press Return and “munger” processes the file. You'll get a
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summary of the operation, as shown in figure 3.7. The munger.out console
window remains present, and you have to pick Quit from the File menu to
leave “munger.” When you do so, a dialog box appears that asks if you
want to save munger.out's contents. Click on the Save button if the console
window’s output is important to you. Otherwise, click on Don't Save to
discard the console window's output. This feature enables you to capture
the output of a job as required. For lengthy pathnames, as in our example,
the SIOUX console window lets you copy and paste characters. You only
have to type the pathname in once for the input file prompt, select this text
with the mouse, copy, and then paste the bulk of the pathname into the
prompt for the output file pathname. Now all you have to type is the output
filename.

B === Munger.out %

Enter input file: Tachyon:Codelarrior:Code Examples f:Munger f:PowerPC.txt
Enter output file: Tachyon:CodeWarrior:Code Examples f:Munger f:PowerPC.out

Butes read: 5567
Butes written: 5466

[&5]

Figure 3.7 The console window of program “munger” after it processes a file

Now if you open the resulting file “PowerPC.out” with your favorite word
processor, you'll see that “munger” did handle the surplus CRs (see figure
3.8).
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rt File Edit Font Size Style Format Frame Uiew
i=———————— PowerPC.out (Converted)

IBM-and-Motorola-announce first-silicon-on-PowerPC-603+ k
o

Atthe Microprocessor-Forum today-IBm and Motorola jointly-announced-the first:
fabrication-of the-second-PowerPC-RIS Cmicroprocessor, the-603. This-was-achieved-
lessthan-12 months afterannouncing-initial silicon-onthe-PowerPC.601.-The-PPC-
603 provides-high performance while consuming-little- power, making-it-ideal for-
‘r}otebook-computer-designs.d

The-PPC-603-uses-3.3¥,-0.5micron,-4-level metal, static-CMOS technology to-pack-
1.6:million-ransistors-onto-a-diethat's- 7.4 mm-by-11.5mm.-By contrast, the-PPC.601-
uses-3.6:¥,-0.6:-micron-static.CMOS to-place-2.8-millionfransistors on-a-die-120-mm-
square.-Like the-PPC-601, the-PPC-603-implements-a-32-bit-version-of the-G4-bit:
PowerPC-architecture, with-a-32-bit-address bus-and-a-32--or-64-bit-data-bus. It-uses-
the-same-superscalar-design-with-3-instruction-dispatch.-However, the-PPC-603 does-
differ from-the-PPC-601-inseveralareas. First, the-PPC-603-uses-a-Harvard-
architecture-it-has two-separate-8-KB-caches,-one for-instructions, and-one-for-data..-
Each-cache-has-its-own-MMU.-Both-caches-are two-way-set-associative-and-use-an-
LRU-algorithm.-Next, the-PPC-603-has-5-independent-execution-units.-It-has the-same-
branch prediction-unit{BPU), integer-unit(IU), and floating-point-unit-{ FPU), that-can-
dispatch three-instructions-simultaneously, the same-as-the PPC-601.-However, the-
PPC-603 features a-new: Ioad!store unlt(LS U) -and-system- reglster unit(S RU) thatare-

Figure 3.8 The munged output file

Where’s the Mac?

OK, so we got some C code to run on the Mac, but where is that easy-to-use
Mac interface? The point is that we got code running quickly without getting
mired in too many details. We let the C Standard Library handle the job of
initialization. It also provided I/0 through a Mac window masquer-ading as a
console window. The important thing to carry away from this exercise is that
you can use the C Standard Library to act as a scaffolding while you test
various algorithms and Toolbox calls. The programs you make this way aren't
meant to be friendly, just useful enough to test code. We will start adding our
own Mac interface to our “munge” program in the next chapter.
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Here's another example where the C Standard Library pitches in while we
investigate some Toolbox routines. Under System 7, active applications are
called processes. Certain system services such as File Sharing, PlainTalk
voice recognition, and the Express Modem are actually processes them-
selves. These system services don't show up on the application menu, but
they do operate quietly in the background. As the Mac migrates to a pre-
emptive multitasking OS, processes will become even more important to
the overall operating system design. With that in mind, let's take a closer
look at processes.

Processes Revealed

The Mac OS allocates each process a partition in memory where it runs and
assigns it a unique ID number. This ID number is called the process serial
number (PSN) and it is used by the operating system to reference the
process and control it. Inside Macintosh: Processes documents a group of
Toolbox routines, known collectively as the Process Manager, that manage
these processes and supply information on them. To find out more about
processes, let's examine another quick program. Go the the Code Examples
f folder, and open the Process f folder. Double-click on the “process.c” file.

#include <processes.h>
#include <stdio.h>

void main (void)

{

register int i

ProcessInfoRec thisProcess;

ProcessSerialNumber process;

FSSpec thisFileSpec;

unsigned char typeBuffer[5] = {0};

unsigned char signatureBuffer[5] = {0};

thisProcess.processAppSpec = &thisFileSpec; /* Aim pointer at our storage */

thisProcess.processInfoLength = sizeof (ProcessInfoRec); /* Store record size */
thisProcess.processName = (unsigned char *) NewPtr(32); /* Allocate room for the name */
process.highLongOfPSN = kNoProcess; /* Clear out process serial number */
process.lowLongOfPSN = kNoProcess;

while (GetNextProcess(&process) == nokErr) ’ /* Loop until all processes found */

{
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if (GetProcessInformation(&process, &thisProcess) == noErr) /* Obtain detailed info

*/
{
for (i =0; i <= 3; i++) /* Copy type & sig info into string buffers */
{
typeBuffer[i] = ((char *) &thisProcess.processType)[i];

signatureBuffer[i] = ((char *) &thisProcess.processSignature)[i];
} /*end for */

printf ("Process SN: %l1d, %ld, Type: %s, Signature: %s, Name: ",
thisProcess.processNumber.highLongOfPSN,
thisProcess.processNumber.lowLongOfPSN,
typeBuffer,
signatureBuffer);

printf (" %s \n", P2CStr(thisProcess.processName)); /* Now print the name */

} /* end if */

} /* end while */
} /* end main() */

This program uses the Process Manager to obtain information about all of
the processes running on the system. Notice that we include one more
header file, <processes. h>, to the source. This header file defines the Pro-
cess Manager routines and a data structure called ProcessInfoRec that acts
as a container for all of the process’s relevant information. The lines:

thisProcess.processAppSpec = &thisFileSpec; /* Aim pointer at our storage */
thisProcess.processInfoLength = sizeof(ProcessInfoRec); /* Store record size */
thisProcess.processName = (unsigned char *) NewPtr(32); /* Allocate room for the name */
process.highLongOfPSN = kNoProcess; /* Clear out process serial number */
process.lowLongOfPSN = kNoProcess;

are used to set up our local copy of ProcessInfoRec, called thisProcess. Then
we direct pointers in thisProcess to the appropriate storage locations. For
example, processAppSpec, which contains the location of the file that created
the process, is aimed at thisFileSpec. And processName, which holds the
process’s name, is directed to a chunk of memory allocated by NewPtr(), a
Toolbox memory allocation routine. Last, we clean out the PSN variables by
assigning kNoProcess, which equals zero, to it.

Now we use a while loop that calls the Process Manager routine
GetNextProcess () repeatedly. GetNextProcess (), when called with a PSN of O,
starts at the beginning of an internal list of PSNs maintained by the Process
Manager and returns the first PSN on the list. By passing each returned PSN
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back to GetNextProcess () on subsequent tours of the loop, we walk this list
and use another routine, GetProcessInformation(), to grab information on
every process in the system. When GetNextProcess () finally reaches the
end of the PSN list, it returns an error value and the loop completes.

While the loop cycles, GetProcessInformation() extracts in-depth informa-
tion on the current process and stuffs it into thisProcess. As usual, notice
that we check for errors. If GetProcessInformation() reports no errors after
it completes, we dump some of the information it gathered to the console
window.

Gathering Processes

It's time to compile the “process.c” program and see what it gathers. There
are seven steps, and they are nearly identical to the first program,
“munger.”

1. Save the code (if you typed it in) into a file called “process.c.”

2. Create a new project called process.r, and add “process.c” to the
project. Then round up the usual suspects, “InterfaceLib,” “MathLib,”
“MWCRuntime.Lib", “ and “ANSI C.PPC.Lib" and add them as well. The
Project window should resembile figure 3.9.

== Pracess.n =——
File Code Data B ¥
ANSICPPCLib | GH GH Ol
InterfaceLib o o} 8l
MathLib o o 5]
M¥CRuntime.Lib : H [l o]

B

5 file(s) OK 0K

Figure 3.9 The Project window for the process program

3. Set the Language and Warning preferences the same way you did for
the Munger.nt project.
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4. In the Linker preferences panel, check the entry point settings. As
mentioned previously, the defaults for this program are fine, but you
should get into the habit of visiting this panel when we start writing
more capable Mac applications.

5. Name the output file Process in the Project preferences panel.
6. With all the preferences set, make the program.

7. Finally, pick Run from the Project window. The console window
appears and displays information on each process’s PSN, type, signa-
ture, and name (see figure 3.10). Note the presence of our own pro-
gram, “Process,” as well as the CodeWarrior compiler, the Finder, the
File Sharing Extension, and other applications.

{3

Process SN: 0, 8192, Type: FNDR, Signhature: MACS, Name: Finder s
, 8193, Type: INIT, Signature: hhgg, Name: File Sharing Extension

, 8195, Type: APPL, Signature: MPCC, Name: MW C/C++ PPC v1.0adpi

8197, Type: APPL, Signature: MWPR, Name: MacWrite Pro

8199, Type: APPL, Signature: zTRM, Name: ZTerm 0.9

8200, Type: APPL, Signature: ????, Name: Process

Process SN:
Process SN:
Process SN:
Process SN:
Process SN:

I

coooo00

EE

Figure 3.10 The process program displaying all processes on the system

A Word of Caution

As you can see, with the assistance of the I/0O functions provided by the C
Standard Library, you easily can delve into the Mac's inner workings. Even
with all the Mac code I've written over the years, I still frequently use the C
Standard Library I/0 functions to quickly test code that uses unfamiliar
Toolbox routines.
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)
W Hazard
L A Since the C Library does its own application initialization, you need to exercise
caution when mixing this library with certain Toolbox routines. For example, the

printf() function has the C Library create a Mac window that mimics a
console window. If your program happens to use a Window Toolbox routine, this
creates a situation where your code butts heads with the window data struc-
tures created by the C Library, and causes a crash.

To avoid this pitfall, never match the 1/0 functions you use with the Mac Toolbox
with those of the C Library in the program. If you use QuickDraw or Window
Toolbox routines in your code, don't use the C Library functions that require a
console window. Or, if your program uses the C Library’s file I/0 functions, don't
use Mac Toolbox's file I/0 routines. Also be aware that not all of the C Library
functions are implemented. Check the CodeWarrior's C Library Reference manual
for any discrepancies.

Just the Beginning...

In this chapter we've seen how to build a practical application, leveraging
off the I/0 functions in the C Standard I/0 Library. We outlined seven
steps required to build and run the application in Metrowerks CodeWarrior.
We also examined how to use the C Library to help us experiment with
various Toolbox routines in isolation. Now we can apply this knowledge to
learn how the Mac works, which ultimately assists us in writing Mac
applications. Try some experiments of your own, and then proceed to the
next chapter where you'll write a full-blown Mac application.
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Using the Toolbox

At this point you should be comfortable with the Metrowerks
CodeWarrior integrated development environment and how to
create and manage a project. In a jam, you can rely on
CodeWarrior's C Standard Library to help you learn how to use
new and unfamiliar Mac Toolbox and OS routines. Does this
mean you're ready to write a full-fledged Macintosh applica-
tion? Not quite. For novice Macintosh programmers, there are a
number of basic concepts to learn. These include program
initialization, resources, event handling, and the structure of
files. These concepts cover a lot of ground, but I'll keep the
information doses manageable by introducing them in stages,
along with programs that demonstrate these aspects of the
Mac OS. Readers with intermediate Mac expertise
may wish to jump to the back of the chapter and
study the code on Apple Events. The rest of us will
catch up with you later.

In chapter 3, I
mentioned a
Process Manager.
Aswe learned, it
is a collection of
routines that deals
with processes,
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which are running applications. It should come as no surprise that many of
the Toolbox routines are organized into groups of related functions, or
Managers. There's the Event Manager, which deals with low-level events
such as mouse clicks and keystrokes. A Memory Manager has routines that
allocate memory, release memory, and adjust the size of the stack. A
Window Manager provides routines necessary for the care and feeding of
windows, while a Font Manager deals with the various fonts you see on the
screen or use to print. The list goes on and on. One of the few exceptions to
this naming scheme is QuickDraw—the routines that handle drawing on the
screen or onto a page ifnage bound for the printer. These various Managers
serve as libraries of routines available for your use.

|

Important

For 68K Macs, a routine’s entry point is handled by a 680x0 processor excep-
tion. With the Power Macs, the various routines now actually exist in code
libraries.

'=

What's nice about this scheme is that it helps organize all of those thou-
sands of Toolbox routines. For example, if you need a function that reads a
file, look at the File Manager routines. As a novice, you should spend some
time just browsing through Inside Macintosh. The new editions organize
the technical content by category, such as files, memory, text, and so forth,
rather than by volume number as they did in the past. This arrangement
helps you locate the various Managers by function. Along with the usual
reference information, the new editions of Inside Macintosh also include
some tutorial material. You might not understand all of the information
presented there (for now), but it will give you a good idea of what Manag-
ers exist, and what they do. When necessary, I'll make reference to the
appropriate Inside Macintosh edition.

Meet Some Managers

To get you used to the idea of Managers, let's start by rewriting that “Hello
world” program that we wrote in chapter 2. This will also demonstrate how
to initialize a Mac application. Start by opening the Code Examples f folder.
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Now open the MacHello f folder and double-click on “hellol.c.” Now let's
take a close look at the code:

#include <Types.h>
#include <QuickDraw.h>
#include <Fonts.h>
#include <Windows.h>
#include <Memory.h>
#include <Events.h>
#include <OSUtils.h>

#define NIL oL
#define IN_FRONT (-1)
#define IS_VISIBLE TRUE

#define NO_CLOSE_BOX FALSE

Already you'll notice that there are a lot more header files involved than
just using the Standard C Library's <stdio.h>. That's because the Standard
C Library includes every I/0O function possible plus the kitchen sink. In
contrast, each Toolbox Manager has a separate header file. This keeps
both your workload and the compiler’s at a manageable level. It means that
you have to be more aware of what routines you plan to use (yet another
reason to browse through Inside Macintosh).

VI‘ j

Background Info \
Like Symantec’s THINK C, the Metrowerks CodeWarrior compiler uses a special \’///
header file called “MacHeaders68K” or “MacHeadersPPC,” depending upon the
type of code you're generating (68K or PowerPC, respectively). These files
incorporate the most frequently used header files, such as “QuickDraw.h,”
“Fonts.h,” “Windows.h,” “Files.h,” and others. The “MacHeaders68K" and
“MacHeadersPPC" files are precompiled, which helps boost the compiler’'s
processing speed when it searches for routine definitions. It also means that if
you stick with the most frequently used Manager routines, you needn't worry at
all about typing in include statements. However, not all of the header files are
incorporated into MacHeaders. If you're using some of the more sophisticated
Toolbox routines to, say, play sounds or do special printing, you'll need to
include those files. Or you can edit and recompile the appropriate
“MacHeaders.c” source code file supplied with the CodeWarrior compiler.
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Personally, | prefer to enter all of the header files anyway. You keep better track
of what Managers you're using, which helps with your program design. It doesn't
hurt having the header files declared in your program, because even if you use
the “MacHeaders” file, the Metrowerks CodeWarrior compiler is smart enough
to sort things out and prevent redundant declaration errors from cropping up.

The definitions NIL, IN_FRONT, IS_VISIBLE, and NO_CLOSE_BOX are for use later
in the program. As you'll see, they'll make a Window Manager routine that
we use a lot easier to understand. Now enter:

void main(void)

{
WindowPtr  thisWindow;
Rect windowRect;

/* Lunge after all the memory we can get */
MaxApplZone();
MoreMasters();
MoreMasters();

/* Initialize the various Managers */
InitGraf (&qd.thePort);
InitFonts();
FlushEvents(everyEvent, 0);
InitWindows();

InitCursor();

Now we're getting somewhere. The variable WindowPtr holds a pointer to a
data structure that the Window Manager creates for us. The data helps
manage the window that will display the phrase “Hello world.” Rect is a
data structure that describes a rectangle object to QuickDraw. If you use
the Metrowerks editor to examine the “Types.h” file, you'll find Rect, which
looks like this:

struct Rect {
short top;
short left;
short bottom;
short right;
};

typedef struct Rect Rect;
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Top and left correspond to the x and y coordinates of a point that
QuickDraw uses in its drawing space. The bottom and right variables
define a second point's coordinates. QuickDraw uses these two points to
draw the rectangle. How does it make a rectangle made up of four points
(or eight x and y coordinates) with just two points? QuickDraw relies on the
fact that a rectangle can be drawn with this amount of data. First,
QuickDraw draws a line from point (top, left)to point (top, right)to
draw the top of the rectangle. Next, QuickDraw draws a line from point
(top, right)to point (bottom, right), which draws the right side of the
rectangle. Then QuickDraw follows with a line from point (bottom, right)
to point (bottom, left)to draw the bottom of the rectangle. The line drawn
from point (bottom, left)to point (top, left)closes the rectangle.

MaxApplZone () is a Memory Manager routine that ensures the application
has sufficient memory. It does this by expanding the application’'s heap
(also called a zone) as much as possible within the memory partition built
for it by the Process Manager. This is followed by calls to MoreMasters(), a
routine that allocates what are called master pointer blocks. These blocks
contain pointers that help implement the handles that are frequently used
to access Toolbox data structures. If you run out of master pointers, the
Memory Manager will create more for you automatically. However, since
the master blocks can't move about in memory, you run the risk of frag-
menting the application’'s heap as memory becomes littered with these
immovable memory blocks. The application will also run more slowly as it
struggles to organize the fragmented memory. If you provide sufficient
master blocks now, it eliminates potential memory and performance
problems in the future. Obviously, it's better to call MoreMasters() too much
at initialization time, rather than too little.

Initializing Managers
Now we initialize the various Managers that we plan to use:

InitGraf (&qd.thePort);
InitFonts();
FlushEvents(everyEvent, 0);
InitWindows();

InitGraf () initializes QuickDraw. QuickDraw in turn sets up some global
variables it uses to manage the application’s graphic environment. The
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storage for these variables is set up by the development system, which
QuickDraw accesses via the global pointer thePort that you provide. Next,
the Font Manager is initialized, so that text can be displayed within the
window. FlushEvents () clears the event queues of any stray events when
the application launched. InitWindows (), of course, readies the Window
Manager.

Now it's time to get into the actual mechanics of displaying the phrase
“Hello world.” Add to the program:

/* Set up the window */
windowRect.top = windowRect.left = 40;
windowRect.bottom = 200;
windowRect.right = 300;
if ((thisWindow = NewWindow(NIL, &windowRect,
"\pHello world“, IS_VISIBLE, documentProc,
(WindowPtr) IN_FRONT, NO_CLOSE_BOX, NIL)) != NIL)

{
SetPort(thisWindow); /* Make window the current port */

MoveTo (20, 20);
DrawString("\pHello world");
InitCursor();

while (!Button()) /* Wait until mouse button clicked */

3

DisposeWindow(thisWindow); /* Clean up */
} /* end if */

else
SysBeep(30);

} /* end main() */

The first two lines of code plug coordinate data into the rectangle
windowRect that are used to make the window. If you're puzzled over the
point data's positive values, that's because in QuickDraw's coordinate
system, the upper left corner of the screen is the origin, and larger positive
numbers move a point toward the right and downwards. The values in
windowRect have QuickDraw create a window located forty pixels down
and forty pixels to the right of the screen'’s origin. The window's upper left
corner starts at this position, and the window is two hundred pixels tall and
three hundred pixels wide.
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The NewwWindow () routine actually makes the window. The #defines we
created at the top of the program are put to use here. From them we can
surmise that the new window is visible on the screen, is supposed to
appear in front of all other windows, has no close box (the small square in
the window’s upper left corner that, when clicked on, removes the win-
dow), and its title will be Hello World. NewWindow()'s first argument allows
you to place a pointer to a data buffer for the window's use. If this argu-
ment is NIL, as it is in our example, the Window Manager allocates the
window's data storage on the heap, which is fine for simple operations.
However, if you display lots of text or large color images in the window,
you can severely fragment the heap. For these jobs, it's best to pass the
address of a memory block to NewwWindow (). Consult Inside Macintosh:
Macintosh Toolbox Essentials and Inside Macintosh: Memory for more
information on these issues.

Notice that we do some error checking here. If NewWindow () successfully
creates the window, it will return a pointer to the window's data structure.
If NewWindow () has a problem making the window (possibly there’s not
enough memory), the routine returns a value of NIL. The if statement
determines if we received a valid pointer from the Window Manager. If not,
the application beeps and exits. Admittedly, a beep doesn't offer much
diagnostic aid to the user, but it's preferable to signal a problem this way
and quit cleanly, rather than have the Mac crash.

If we have a valid window pointer, the program next sets the window to
be the current drawing port by using SetPort (). QuickDraw always draws
to the screen through a graphics port or grafport, which is another data
structure that describes to QuickDraw an area to draw on the screen, the
size and shape of this area, its coordinate system (which can be different
from the screen’s), what type of text to use, and other information. The
Window Manager creates a grafport for every window it makes, and your
application can create and manage many windows—and thus grafports—at
once. Through the SetPort () routine, we inform QuickDraw what grafport
to draw in, which in this case is our shiny new window. The following
MoveTo routine nudges the current drawing point within the window down
and right twenty pixels. These values use the window's own coordinate
system, whose origin is located at the window's upper left corner. Finally,
we use the DrawString () routine to write the phrase “Hello world” in the
window.
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When the Process Manager starts the application, it changes the mouse
pointer, or cursor, to a stopwatch to indicate the Mac is busy. Now that our
initialization code has completed and the program displays the greeting,
we call InitCursor(), which changes the cursor back to an arrow. This
indicates that our application is ready to deal with the user.

If we simply let the program proceed, the window would appear briefly
and be gone. To let the window linger so that we can admire our handi-
work, we insert a while loop. This loop cycles until the routine Button()
returns TRUE, which occurs when you press the mouse button. Once the
loop completes, we clean up after ourselves by calling DisposeWindow(),
which removes the window and purges the data structure made by
Newwindow (). The final shape of the program looks like so:

#include <Types.h>
#include <QuickDraw.h>
#include <Fonts.h>
#include <Windows.h>
#include <Memory.h>
#include <Events.h>
#include <OSUtils.h>

#define NIL oL
#define IN_FRONT (-1)
#define IS_VISIBLE TRUE
#define NO_CLOSE_BOX FALSE

void main(void)

{
WindowPtr  thisWindow;
Rect windowRect;

/* Lunge after all the memory we can get */
MaxApplZone();
MoreMasters();
MoreMasters();

/* Initialize the various Managers */
InitGraf (&qd.thePort);
InitFonts();
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FlushEvents(everyEvent, 0);
InitWindows();

/* Set up the window */
windowRect.top = windowRect.left = 40;
windowRect.bottom = 200;
windowRect.right = 300;
if ((thisWindow = NewWindow(NIL, &windowRect,
"\pHello world", IS_VISIBLE, documentProc,
(WindowPtr) IN_FRONT, NO_CLOSE_BOX, NIL)) != NIL)

{
SetPort(thisWindow); /* Make window current drawing port */

MoveTo (20, 20);
DrawString("\pHello world");
InitCursor();

while (!Button()) /* Wait until mouse button clicked */

3

DisposeWindow(thisWindow) ;
} /* end if */

else
SysBeep(30) ;

} /* end main() */

Run the Code

Let's compile and run this code. Using the seven-step procedure outlined in
chapter 3, we first save the code (if we typed it) into a file called Hello1.c.
Next, create a project called Hello.n. Add “Hellol.c,” “InterfaceLib,” and
“MWCRuntime.Lib" to it. (Remember that you don't need to do this with the
limited version. The project is already made.)

Set the preferences in this project for the Language, and Project groups. For
the Language preferences panel, ensure that the Require Function Proto-
types item is checkboxed, and in the Warnings panel that the Extended
Error Checking item is checkboxed. For the Project preferences panel,
name the output file Hello. Now make the project and run it. You'llget a
window that resembles that shown in figure 4.1.
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E——— Hello world ———

Hello world

Figure 4.1 The result of the “Hello world” program

Click on the mouse button to quit the application. The font used in the
window was the default application font Geneva. One of Mac OS's finer
features is that it has a smart set of defaults, which simplifies program-
ming.

It took fifty lines of code to implement the “Hello world” program. Our
resulting application doesn't do much—but then neither did the UNIX-style
version of the program that we wrote in chapter 2. It does illustrate that the
Mac OS is a complex environment that requires attention to a lot of details
before you can write code.

This very simple application required that we have a grasp of the Memory
Manager, the Window Manager, and QuickDraw. I've only provided super-
ficial descriptions of some of the Toolbox routines used in the setup code.
For additional information, consult Inside Macintosh: Macintosh Toolbox
Essentials, Inside Macintosh: Memory, and Inside Macintosh: Imaging.

“Hellol.c” demonstrates the general initialization setup for a Mac applica-
tion. Later programs will require the setup of more Managers, but these will
be just additions to the code you've written here. Like the understanding of
the Mac itself, Mac programming is just a matter of continually adding
components to a basic structure.

The Fork in the File

Now that we've covered program initialization, let's delve into a Mac file's
structure. A Macintosh file is composed of two sections, a data fork and a
resource fork. Physically, there's nothing different about these forks; each is
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simply a stream of bytes located somewhere on the hard disk. However,
the Mac OS treats each file fork differently. The data fork typically contains
data created by an application, such as text from a word processor, num-
bers from a spreadsheet, or PostScript commands from a drawing applica-
tion.

The resource fork is a container for objects called—you guessed it—re-
sources. Resources contain data that's organized into predefined formats.
This data typically describes graphic elements such as icons, windows,
and color tables. Resources also contain non-graphic yet essential elements
such as drivers or program code. A resource type defines the resource to
the Mac OS, so that it can properly interpret the data packaged within the
resource. A resource type is a four-character code, such as ‘CODE’, MENU’,
‘WIND’, ‘cicn’, ‘cdev’, and so on. As examples of how the resource type
indicates what's inside a resource, consider that CODE resources contain
processor code, MENU resources contain the items that appear on a menu,
and cicn resources hold data that displays a color icon. In summary, the
resource fork of a 68K application contains such elements as program code,
menu lists, windows, and icons. The structure of a Power Mac application
is somewhat different: It still keeps the graphical elements in its resource
fork, but the program code is stored as a single block inside the file's data
fork. More on this later. For more details on a file's data and resource forks,
consult Inside Macintosh: Files, and for more on resources, check Inside
Macintosh: Macintosh Toolbox Essentials.

Besides the two forks, each file also has a type and creator. Like resource
types, file type information is a four-character code that describes a file's
contents to the application that opens it. For example, a file type of ‘TEXT"
indicates that the file contains ASCII text, “TIFF' indicates the file has
Tagged Image File Format bit-mapped data (typically a scanned image),
and ‘APPL’ means the file contains program code and is thus an applica-
tion. The creator information is a four-character code signature that's
unique to the application that created the file. Each file's type and creator
information is maintained in a desktop database file by the Mac OS. Where
does the desktop database get the type and creator information from?
From resources in your program, of course. The Finder, the shell applica-
tion that displays and manages the so-called virtual desktop on your Mac's
screen, uses the database file to display each file's icon at the appropriate
screen location.
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To see how all this fits together, consider what happens when you double-
click on an document icon (say, a CodeWarrior project file). The Finder
detects this action, and obtains the file's creator information from the
desktop database. Next, it searches for a file of type ‘APPL’ (an application)
with the same creator signature. If the Finder finds this application file (the
CodeWarrior compiler), it has the Process Manager launch that application.
If the Finder can't locate the application file, you get a warning onscreen
that states: “The document ‘Foobar’ could not be opened, because the
application program that created it could not be found.”

Obviously, the Metrowerks CodeWarrior compiler manages the CODE
resources in the application that we make. However, to build a complete
Mac application with menus, windows, its own custom icon, and signature
information, it's probably dawning on you that you're going to have be-
come familiar with resources in greater detail. This assessment is correct,
S0 let us begin.

Making Resources

As usual, the best way to learn about resources is to do something with
them. A great place to start would be to put a friendly interface on that
user-hostile file munger program we wrote in chapter 3. First, consider
what we want the munger program's interface to do. It should basically
behave as before and let you pick a file to open, ask you to name an output
file, and then process the chosen file. When munger finishes the job, you
want a status report. Once you've finished processing one or more files, you
quit munger. With some thought, we conclude that all the munger applica-
tion really needs is an Apple menu, a File menu, and an Edit menu. The
Apple menu is just a placeholder for an application's About Box, the win-
dow where the program's description hangs out. The File menu needs an
Open command to open the desired files and a Quit command to exit the
program. The Edit menu won't be of much use to our application,; it's there
to assist passing events to other applications under System 7's cooperative
multitasking environment. We also need to design dialog boxes, which are
the windows that display processing statistics and warn of problems.
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Finally, we want to display a cool About Box dialog box that describes
munger when the About command is chosen from the Apple menu.

Locate ResEdit, the resource editor, in the Apple Tools folder on the
CodeWarrior CD-ROM and copy it to your hard disk, if you haven't done so
already. As its name implies, ResEdit is a resource editor. It lets you create
resources, modify them, and save them to a file's resource fork, much like a
text editor does with text data in a file's data fork. Launch ResEdit. Click on
the splash screen to dismiss it. Click on the New button. When the Stan-
dard File dialog box appears, type in munger.x.rsrc.

Hazard G (
It's very important that you type the filename exactly as it appears. That's L z

because when you test drive an application in the CodeWarrior IDE, it does
some important housekeeping for you. CodeWarrior searches for resources
(except for the CODE resources that it made) in a file whose name begins with
the project name and ends with the string “.rsrc.” For example, for project
munger.m, we'll keep our resources in a file called “munger.m.rsrc.” This setup
allows you to rapidly modify graphical resources without having to attach the
them to the program'’s resource fork every time you want to test changes to the
interface.

A window called munger.T.rsrc appears. This window serves as a view of
the file's resource fork. It's empty because there are no resources in it—yet.
Thinking back to our interface design meeting a little while ago, we de-
cided that munger needed several menus. Go to the Resource menu and
choose the Create New Resource command, as shown in figure 4.2.



Power Macintosh Programming Starter Kit

[ & File Edit GGG Window  Uiew

Eme— Create New Resource 3K

~1  Open Pickers

Open Using Template... Nevirino
Open Picker by 1D

Revert Resource Types

Get Resource info ®1

Figure 4.2 Preparing to make a new resource in ResEdit

Making Menus

A dialog box appears, asking for a resource type. You can either scroll
through the list of defined resource types or type in one if you know it. Type
in MENU (as shown in figure 4.3) and press Return.

Select New Type

Figure 4.3 Making a MENU resource
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Two new windows appear (see figure 4.4). The frontmost belongs to the
menu resource editor, used to create and modify MENU resources. Say, this
looks promising. But what's that MENU ID =128 in the window title? To
distinguish among resources of the same type (MENU, in this case), each
resource has its own ID number. To uniquely identify and use a single
resource, you specify its type and this ID number. The resource ID number
is a 16-bit signed value. ID numbers from -32768 through 127 are reserved
for use by the Mac OS, while you're free to use ID numbers from 128 to
32767. What ResEdit's menu resource editor did when it created the re-
source was conveniently pick the first available ID number.
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Figure 4.4 The MENU resource editor

Since the first menu is the Apple menu, click on the Apple menu radio
button in this window. The word Title changes to the Apple symbol, as
shown in figure 4.5. Note also that the outlined menu formerly named Title
in the menu bar changed to the Apple symbol as well. This menu is a clone
of the menu you're constructing and it's used 